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File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Print Prints a document.
Print 
Preview

Displays the document on the screen as it would appear printed.

Exit Exits Nero.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Cut Deletes data from the document and moves it to the clipboard.
Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple documents in the application window:

New Window Creates a new window that views the same document.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Split Split the active window into panes.
Window 1, 
2, ...

Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Help 
Topics

Offers you an index to topics on which you can get help.

About Displays the version number of this application.



Open command (File menu)

Use this command to open an existing document in a new window.    You can open multiple 
documents at once.    Use the Window menu to switch among the multiple open documents.  
See Window 1, 2, ... command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open.

Drives
Select the drive in which Nero stores the file that you want to open. 

Directories
Select the directory in which Nero stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    Nero suggests 
that you save changes to your document before you close it.    If you close a document 
without saving, you lose all changes made since the last time you saved it.    Before closing 
an untitled document, Nero displays the Save As dialog box and suggests that you name 
and save the document.

You can also close a document by using the Close icon on the document's window, as shown 
below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When 
you save a document for the first time, Nero displays the Save As dialog box so you can 
name your document.    If you want to change the name and directory of an existing 
document before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    Nero displays the Save As 
dialog box so you can name your document.    

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    Nero adds the 
extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.    Choose the number that corresponds with the document you want 
to open.



Exit command (File menu)

Use this command to end your Nero session.    You can also use the Close command on the 
application Control menu.    Nero prompts you to save documents with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo/Can't Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.      The name of the 
command changes, depending on what the last action was.    The Undo command changes to
Can't Undo on the menu if you cannot reverse your last action.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on 
the clipboard.    This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if
there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This 
command is unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in Nero, such as File Open.    A check mark appears next to the 
menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in Nero,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

<< Add or remove toolbar buttons from the list below according to which ones your 
application offers. >>

Click To

Open an existing document.    Nero displays the Open dialog box, in which you can 
locate and open the desired file.

Save the active document or template with its current name.    If you have not named
the document, Nero displays the Save As dialog box.

Print the active document.

Remove selected data from the document and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Nero window.    To display or hide the status 
bar, use the Status Bar command in the View menu.



New command (Window menu)

Use this command to open a new window with the same contents as the active window.    You
can open multiple document windows to display different parts or views of a document at 
the same time.    If you change the contents in one window, all other windows containing the 
same document reflect those changes.    When you open a new window, it becomes the 
active window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



Split Command (Window menu)

Use this command to split the active window into panes.    You may then use the mouse or 
the keyboard arrows to move the splitter bars.    When you are finished, press the mouse 
button or enter to leave the splitter bars in their new location.    Pressing escape keeps the 
splitter bars in their original location. 



1, 2, ... command (Window menu)

Nero displays a list of currently open document windows at the bottom of the Window 
menu.    A check mark appears in front of the document name of the active window.    Choose
a document from this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using Nero and various types of reference information. 

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Nero.



Context Help command 

Use the Context Help command to obtain help on some portion of Nero.    When you choose 
the Toolbar's Context Help button, the mouse pointer will change to an arrow and question 
mark.    Then click somewhere in the Nero window, such as another Toolbar button.    The 
Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Nero window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    Nero determines which 
window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    Nero determines 
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window. 
Please contact the supplier of Nero for further help. 



No Help Available

No help is available for this message box.





Print command (File menu)

Use this command to print a compilation.      This command presents a Print dialog box, 
where you may specify the range of pages to be printed, the number of copies, the 
destination printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the compilation should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire compilation.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that Nero is sending output to the printer.    
The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active compilation as it would appear when printed.    When
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the compilation; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the compilation is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>



Help Topics
Recording a CD with Nero
CD-ROM (ISO)
Audio-CD
Mixed-Mode CD
Bootable CD
HFS CD
Hybrid CD
Multisession CD
Creating a Multisession CD
Continuing a Multisession CD
CD Format- Checking

Image file
Creating an Image File
Writing the Image File

CD-Copy
CD-Copy with Nero
CD-Copy step by step
More about Copy on-the-fly
Checking the audio features of your CD-ROM drive

Saving tracks with Nero
Saving audio tracks
Saving data tracks

The Nero Multi Mounter
Nero Multi Mounter

FAQs (frequently asked questions)
Nero general questions
Operating system specific questions
Recorders supported by Nero
SCSI-Adapters supported by Nero



More help?
Context-sensitive Help
Support provided by ahead



CD-ROM (ISO)
We will show you, step by step, how you use Nero to create and record a CD-ROM (ISO)

We will leave all the options with their default settings. For detailed information, please refer to the 
Reference Chapter in the manual. The manual is on the Nero-CD in the form of an Acrobat document.

Introduction

Normally Nero writes ISO tracks using the CD sector format „Mode 1“. Starting with version 3.0.1 Nero 
supports also the „Mode2/XA“ format. The XA format is an extension of the ISO structures and may only 
be written in the CD sector format „Mode 2“. If you read Mode2/XA-CDs using a PC, DOS/Windows and 
a modern CD-ROM drive both Mode 1 and Mode2/XA CDs may be used. You won´t see any difference 
between Mode 1 and Mode2/XA CDs.

Follow the instructions carefully. Good luck!

1. Click on the CD-ROM (ISO) icon in the New Compilation dialog window which opens after you start 
Nero. If you have already opened Nero, you can reach this dialog window through the icon for "New 
Compilation".

On the property sheets, the Multisession card is on the top.

2. By opening the property page File Options you can switch between Mode 1 and Mode2/XA. The 
mode settings can be found in the upper right corner of this page. If these settings appear      
dimmed/disabled, then these settings can´t be modified right now. This might for example be the case
if you have created an ISO CD Mode 1 and want to continue it using Mode 2. A CD which has been 
recorded with different ISO or sector formats might be unreadable!

3. Now click on the New button at the right.

The corresponding blank compilation window for CD-ROM opens. 

4. Using drag&drop, compile the files for the CD by clicking on the desired files in the File Browser with 
the mouse and then dragging them into the compilation window.

If the File Browser has not yet been opened, you can do that now by entering the VIEW>New File 
Browser command or by clicking on the File Browser icon.

5. Now open the Write dialog. The easiest way to do this is to click on the Write CD icon in the toolbar. 
You will then go to the Write CD dialog box, which will undoubtedly look familiar to you: it is the same 
box which you saw for the creation of a new compilation, only now the Burn property sheet is shown 
on the top. 

6. You will see several boxes, some of which are already selected. Determine maximum speed and 
Simulate are already selected, and you may now also select Write. 

If you wish to create a CD-ROM as a single session, you must click on the Finalize CD box. Do not 
click this box for a session of a multi-session CD, unless it is the last session. The CD is write-
protected after this.

7. Now you may confirm by clicking on the Write button. All of the selected steps will now be carried out 
in sequence including the burn process. So that you can follow exactly what is happening, a status 
window is displayed in which the individual steps are listed. 

As a last step, you will see a message like "burn process was successful with 2x(300 KB/s)".



8. Finally, the CD will be ejected.

9. You may now check to see for yourself what was written onto your new CD by re-inserting the CD and
clicking on the CD info icon.



Audio-CD
We will show you, step by step, how you use Nero to create and record an Audio-CD. 

We will leave all the options with their default settings. For detailed information, please refer to the 
Reference Chapter in the manual. The manual is on the Nero-CD in the form of an Acrobat document.

Follow carefully the instructions. Good luck!

1. Insert    in your recorder the original CD you want to extract audio tracks from.

2. An important prerequisite for creating Audio CDs with Nero is that the music files are available in 
WAV format with 44.1 kHz and 16-bit stereo.

3. If the    audio tracks you want to write to a CD are not in a Wav.format, please save them first into this 
format (see Saving audio tracks).

4. Click on the Audio-CD icon in the New Compilation dialog window which opens after you start Nero. 
If you have already opened Nero, you can reach this dialog window through the icon for "New 
Compilation".

On the property sheets, the Audio-CD card is on the top.

5. Now click on the New button at the right.

The corresponding blank compilation window for Audio CD opens. 

6. If the File Browser has not yet been opened, you can do that now by entering the VIEW>New File 
Browser command or by clicking on the File Browser icon.

7. Using drag&drop, compile the files for the Audio CD by clicking on the desired files in the File 
Browser with the mouse and then dragging them into the compilation window.

8. Now open the Write CD dialog. The easiest way to do this is to click on the Write CD icon in the 
toolbar. You will then go to the Write CD dialog box, which will undoubtedly look familiar to you: it is 
the same box which you saw for the creation of a new compilation, only now the Burn property sheet 
is shown on the top. 

9. You will see several boxes, some of which are already selected. Determine maximum speed and 
Simulate are already selected.

Since an Audio-CD as defined by the Red Book Standard is always a single-session CD, the Finalize 
CD box is selected.

10. Confirm by clicking on Write.

11. Finally, the CD will be ejected.

12. You may now check to see for yourself what was written onto your new CD by re-inserting the CD and
clicking on the CD info icon.

 



Mixed-Mode CD
We will show you, step by step, how you use Nero to create and record a Mixed-Mode CD. 

We will leave all the options with their default settings. For detailed information, please refer to the 
Reference Chapter in the manual. The manual is on the Nero-CD in the form of an Acrobat document.

Follow the instructions carefully. Good luck!

1. Click on the Mixed-Mode icon in the New Compilation dialog window which opens after you start 
Nero. If you have already opened Nero, you can reach this dialog window through the icon for "New 
Compilation".

On the property sheets, the Multisession card is on the top.

2. Now click on the New button at the right.

The corresponding blank compilation window for Mixed-Mode CD opens. This window combines the 
two windows, CD-ROM (ISO) and Audio-CD, into one window with two separate sections.

3. If the File Browser has not yet been opened, you can do that now by entering the VIEW>New File 
Browser command or by clicking on the File Browser icon.

4. Click on the desired data files in the File Browser with the mouse and then drag them into the data 
section, in the upper part of the window. Do the same with the desired audio tracks but drag them into
the audio section, in the lower part of the window. 

Important: the selected audio tracks must be in Wav.format. If they are not in this format, please save
them first into this format and then drag them into your compilation from the File Browser (refer to 
Saving audio tracks).

5. Now open the Write dialog. The easiest way to do this is to click on the Write CD icon in the toolbar. 
You will then go to the Write CD dialog box, which will undoubtedly look familiar to you: it is the same 
box which you saw for the creation of a new compilation, only now the Burn property sheet is shown 
on the top.

You will see several boxes, some of which are already selected. Determine maximum speed and 
Simulate are already selected.

6. Now you may confirm by clicking on the Write button. All of the selected steps will now be carried out 
in sequence including the burn process. So that you can follow exactly what is happening, a status 
window is displayed in which the individual steps are listed. 

As a last step, you will see a message like "burn process was successful with 2x(300 KB/s)".

7. Finally, the CD will be ejected.

8. You may now check to see for yourself what was written onto your new CD by re-inserting the CD and
clicking on the CD info icon.



Bootable CD
General information concerning bootable CDs

The so called „El Torito“ standard describes how to create bootable CDs for PCs. Unfortunately it´s not 
possible for every PC to boot from a CD. What you need is:

1. either a SCSI Controller equipped with a „new“ controller BIOS allowing to boot from a CD (for 
example Adaptec 2940)    and a SCSI CD-ROM drive connected with the controller 

2. or an IDE/ATAPI CD-ROM drive and a „new“ PC BIOS allowing to boot from CD. You can check that
by looking at the BIOS options. If you can manage to change the boot sequence BIOS settings so 
that the term „CD-ROM“ is mentioned before drive „C“ or „A“ then you´re a lucky owner of a „new“ 
PC BIOS allowing you to boot from your CD-ROM drive.

If neither 1) nor 2) is true for you then your PC unfortunately is unable to boot from CDs. The only way out
of this mess is to upgrade the BIOS of your motherboard (if there an update is available) or to purchase a 
SCSI CD-ROM drive (and/or a SCSI controller equipped with a „new“ controller BIOS).

Types of bootable CDs

To create a bootable CD you need a bootable drive which can be used as model for the bootable CD. 
Generally there are three kinds of bootable CDs:

1. Floppy emulation: To create the bootable CD you need a bootable floppy disk as model. Such a CD 
„behaves“ after booting just as if a floppy disk would have been inserted into the floppy drive. This 
also true for the drive letter which is of course „A:“. The floppy disk drive (normally „A:“) may then be 
accessed through the drive letter „B:“. The amount of the boot data is of course limited by the 
maximum capacity of the floppy disk (for example 1.44 MB).

2. Hard disk emulation: The model for such a CD is a bootable harddisk drive. The bootable CD 
„behaves“ as if it were drive „C:“ after booting. Your „old“ drive „C:“ may be accessed through the 
drive letter „D:“, drive „E:“ becomes „F:“ and so on. Because a CD can only store up to 640MB the 
size of your model drive must not exceed 640MB. For example, if you have a 2GB harddisk with a 
single partition, then it´s impossible to use this drive as model for a bootable CD. All you can do in 
such a case is to change the size of your hard disk partition. Normally, all data is lost if the partition 
sizes is changed using „FDISK“. But there are serveral tools available on the market which allow 
partitioning changes without losing data.

3. No emulation: This feature is designed only for professionals, who want to create their own hard disk
and CD-ROM drivers. This method for example is used for the „Windows NT 4.0 Server CD“.

The model for creating a bootable CD may either be a logical drive (all those drives which may be 
accessed through a drive letter; for example „C:“) or an image file of a drive. Such image files contain all
sectors of a drive stored in a file. Such files may for example be created using „Norton Disk Editor“ or 
„WinImage“.

A very sad limitation of bootable CDs is the fact, that currently no „high level“ operating system like 
Windows 3.11, 95 or NT may be booted from a read only device. This limitation exists because all these 
operating systems try to write on the boot device during the boot process. Of course it´s just impossible to
write to a CD-ROM drive. The resulting write error is fatal and causes the boot process to be aborted. 
Bootable CDs exist for other platforms like MacOS or Unix for several years and are used with great 



success. 

So in the end good old DOS is currently the only operating system that may be booted from a CD. Of 
course, you can create a Windows 95 boot CD and interrupt the boot process by pressing F8 at the right 
time. Booting only DOS again should work perfectly.

How to create bootable CDs with Nero

Bootable CDs may be created only under Windows 95 or NT. 

1. First step is to create a new bootable ISO compilation. This can be done by clicking the menu 
command „File“ -> „New...“. 

2. On the left side of the dialog please choose the icon „CD-ROM (Boot)“.

3. At this point you can see the property page „Boot“. The upper part of this page is used to select the 
kind of model you have as input for the bootable CD. You can choose whether you want to use a 
logical drive or an image file as model for your bootable CD. 

Note: If the desired input device does not appear in the list of possible model drives then the reason 
is probably the size limitation for bootable CDs. The logical drive´s size may not exceed the capacity 
of a CD; that means 640MB.

Note: Please consider that you need to have administrator rights to be able to create bootable CDs 
using Windows NT 4.0. This behaviour is by Microsoft´s operating system design and was chosen to 
prevent hackers from accessing other user´s (possibly secret) files. But to create bootable CDs all 
sectors of a logical drives must be accessible. And the only user who´s got the permission to read all 
sectors using Windows NT is the supervisor.

4. The lower part of the boot property page contains detailled settings for bootable CDs. These settings 
normally are dimmed indicating that Nero will check and set all the expert options automatically for 
you. If you choose to use an image file as model for the creation of a bootable CD, then Nero can´t    
automatically choose those settings for you. In this case in or if you choose to define these settings 
manually you can do so. Of course you´re responsible for the resulting CD. If the settings are 
incorrect you will get an incorrect bootable CD...

5. You can now click on New. The ISO compilation window opens.

6. If the File Browser has not yet been opened, you can do that now by entering the VIEW>New File 
Browser command or by clicking on the File Browser icon.

7. Click on the desired data files in the File Browser with the mouse and then drag them into the 
compilation window.

Note: you can burn a bootable CD without data on it. In that case, you don't have to compile files.

8. Now open the Write CD dialog. The easiest way to do this is to click on the Write CD icon in the 
toolbar. You will then go to the Write CD dialog box, which will undoubtedly look familiar to you: it is 
the same box which you saw for the creation of a new compilation, only now the Burn property sheet 
is shown on the top. 

9. You will see several boxes, some of which are already selected. Determine maximum speed and 
Simulate are already selected.

10. Confirm by clicking on Write.



HFS CD
The Apple Macintosh file system is called „HFS“. CDs containing only HFS data can only be read by an 
Apple Macintosh computer. Hybrid CDs can be read by both Apple Macintosh and IBM PC computers.

To create a HFS CD you need to connect a SCSI harddisk containing one ore more HFS partitions to your
PC. Such HFS harddisk partitions can only be created and edited using an Apple Macintosh computer. 
You also need a Mac to edit file icons and window positions. All that Nero does is to write the HFS data 
„as is“ on a CD. Please remember that the SCSI harddisk must be connected with your PC before 
starting the PC. Otherwise Nero will not be able to detect any HFS partitions. Please check the SCSI IDs 
to be sure your SCSI HFS harddisk has a unique SCSI ID.

How to create a HFS CD

1. Choose the menu command „File“ -> „Burn HFS partition“. A dialog box    opens. This dialog box 
contains a list of all detected HFS partitions. If the list is empty, it means that no HFS partitions have 
been detected. 

2. Select the HFS partition you want to burn and click on „OK“. The usual Nero burn dialog box opens 
allowing you to start the burn process. 

3. You will see several boxes, some of which are already selected. Determine maximum speed and 
Simulate are already selected.

4. Confirm by clicking on Write.

NOTE: Again remember, that HFS CDs can only be read using an Apple Macintosh.



Hybrid CD
Hybrid CDs contain the well known ISO 9660 and additionally the Apple Macintosh HFS file system. Such
CDs will be both readable by Macs and PCs. Nero creates so called „non shared“ Hybrid CDs. That 
means, files to be read by Macs and PCs must exist twice (one ISO and one HFS copy of the file) on the 
CD.

To create Hybrid-CDs using Nero you need to connect your PC with a SCSI harddisk containing the HFS 
partition to be written on the Hybrid CD. Such HFS partitions can only be created and edited using an 
Apple Macintosh computer.

1. Choose the menu command „File“->„New...“ and select the icon „CD-ROM (Hybrid)“. On the right 
hand you see the „Hybrid“ property page containing a list box. This list box shows all detected HFS 
partitions. If it´s empty, it means that no HFS partitions have been detected. 

2. Now select the HFS partition you wish to burn. Click on „New“ and drag all the ISO files to be burned
into the hybrid compilation window. 

3. Now open the Write dialog. The easiest way to do this is to click on the Write CD icon in the toolbar. 
You will then go to the Write CD dialog box, which will undoubtedly look familiar to you: it is the same 
box which you saw for the creation of a new compilation, only now the Burn property sheet is shown 
on the top.

You will see several boxes, some of which are already selected. Determine maximum speed and 
Simulate are already selected.

4. Now you may confirm by clicking on the Write button. All of the selected steps will now be carried out 
in sequence including the burn process. So that you can follow exactly what is happening, a status 
window is displayed in which the individual steps are listed. 

As a last step, you will see a message like "burn process was successful with 2x(300 KB/s)".

5. Finally, the CD will be ejected.

6. You may now check to see for yourself what was written onto your new CD by re-inserting the CD and
clicking on the CD info icon.

NOTE: The Hybrid CD will then show all HFS files if it is read by an Apple Macintosh computer. PCs can 
read the ISO files only.



Multisession CD
We will show you, step by step, how you use Nero to create and record a Multisession CD. 

We will leave all the options with their default settings. For detailed information, please refer to the 
Reference Chapter in the manual. The manual is on the Nero-CD in the form of an Acrobat document.

Nero allows you:

- to record a Multisession CD from a blank disc OR from an ISO CD. See Creating a Multisession CD

- to continue a Multisession CD you have recorder before. See Continuing a Multisession CD



Creating a Multisession CD
We will show you, step by step, how you use Nero to create and record a Multisession CD. Nero allows 
you to record a Multisession CD from a blank disc OR from an ISO CD.

If you want to continue writing a Multisession CD, please see Continuing a Multisession CD

We will leave all the options with their default settings. For detailed information, please refer to the 
Reference Chapter in the manual. The manual is on the Nero-CD in the form of an Acrobat document.

Introduction

Normally Nero writes ISO tracks using the CD sector format „Mode 1“. Starting with version 3.0.1 Nero 
supports also the „Mode2/XA“ format. The XA format is an extension of the ISO structures and may only 
be written in the CD sector format „Mode 2“. If you read Mode2/XA-CDs using a PC, DOS/Windows and 
a modern CD-ROM drive both Mode 1 and Mode2/XA CDs may be used. You won´t see any difference 
between Mode 1 and Mode2/XA CDs.

Follow the instructions carefully. Good luck!

1. Click on the CD-ROM icon in the New Compilation dialog window which opens after you start Nero. 
If you have already opened Nero, you can reach this dialog window through the icon for "New 
Compilation".

2. On the property sheets, the Multisession card is on the top. 

3. Please select the Start Multisession disc option. Make only sure that the No Multisession box is 
not activated.

4. By opening the property page File Options you can switch between Mode 1 and Mode2/XA. The 
mode settings can be found in the upper right corner of this page. If these settings appear      
dimmed/disabled, then these settings can´t be modified right now. This might for example be the case
if you created the ISO compilation using the option „continue multisession“. If you would continue a 
multisession CD using a different ISO- or sector format, then you would be in danger of creating an 
unreadable CD.

5. Now click on the New button at the right.

The corresponding blank compilation window for CD-ROM opens. 

6. Using drag&drop, compile the files for the CD by clicking on the desired files in the File Browser with 
the mouse and then dragging them into the compilation window.

If the File Browser has not yet been opened, you can do that now by entering the VIEW>New File 
Browser command or by clicking on the File Browser icon.

7. Now open the Write CD dialog. The easiest way to do this is to click on the Write CD icon in the 
toolbar. You will then go to the Write CD dialog box, which will undoubtedly look familiar to you: it is 
the same box which you saw for the creation of a new compilation, only now the Burn property sheet 
is shown on the top.

Important: make sure that the Finalize CD box is not checked, unless you don't want to write your 
CD again, after this session! 

8. Now you may confirm by clicking on the Write button. All of the selected steps will now be carried out 
in sequence including the burn process. So that you can follow exactly what is happening, a status 



window is displayed in which the individual steps are listed. 

As a last step, you will see a message like "burn process was successful with 2x(300 KB/s)".

9. Finally, the CD will be ejected.

10. You may now check to see for yourself what was written onto your new CD by re-inserting the CD and
clicking on the CD info icon.



Continuing a Multisession CD
We will show you, step by step, how you use Nero to continue writing a Multisession CD. 

We will leave all the options with their default settings. For detailed information, please refer to the 
Reference Chapter in the manual. The manual is on the Nero-CD in the form of an Acrobat document.

1. Insert the Multisession CD, you want to continue to record, in your CD writer.

2. Click on the CD-ROM icon in the New Compilation dialog window which opens after you start Nero. 
If you have already opened Nero, you can reach this dialog window through the icon for "New 
Compilation".

3. On the property sheets, the Multisession card is on the top. Make only sure that the No 
Multisession box is not activated, otherwise you are not going to write a multisession CD, but an ISO
CD!

4. Please select the Continue Multisession disc option. 

5. By opening the property page File Options you can switch between Mode 1 and Mode2/XA. The 
mode settings can be found in the upper right corner of this page. If these settings appear      
dimmed/disabled, then these settings can´t be modified right now. This might for example be the case
if you created the ISO compilation using the option „continue multisession“. If you would continue a 
multisession CD using a different ISO- or sector format, then you would be in danger of creating an 
unreadable CD.

6. Now click on the New button at the right. The Select track dialog box opens.

7. Select the track that should be backed up. It will be generally the last ISO track. For this reason, Nero
selects it by default. 

8. Click on the OK button. The corresponding compilation window for Multissession CD opens.

This window displays all information concerning the track you have selected. Depending on the 
refresh options selected in the multisession property sheet, you will see some folders and files shown 
in black or in grey.

Folders and files shown in black designate that they have been changed or recorded on your hard 
disk since your last session. They will be recorded on your CD now. 

Folders and files shown in grey designate that they are already on your CD. They have been 
recorded during your last session and have not been changed. They are not going to be physically 
rewritten.

9. Now open the Write CD dialog. The easiest way to do this is to click on the Write CD icon in the 
toolbar. You will then go to the Write CD dialog box, which will undoubtedly look familiar to you: it is 
the same box which you saw for the creation of a new compilation, only now the Burn property sheet 
is shown on the top.

Important: make sure that the Finalize CD box is not checked, unless you don't want to write your 
CD again, after this session! 

10. Now you may confirm by clicking on the Write button. All of the selected steps will now be carried out 
in sequence including the burn process. So that you can follow exactly what is happening, a status 
window is displayed in which the individual steps are listed. 



As a last step, you will see a message like "burn process was successful with 2x(300 KB/s)".

11. Finally, the CD will be ejected.

12. You may now check to see for yourself what was written onto your new CD by re-inserting the CD and
clicking on the CD info icon.



CD Format- Checking
Tracks of different format may not be written on a CD in any arbitrary sequence. There are several well 
defined standard CD formats, which may be read by most CD-ROM drives. Among these well defined 
CD formats is for example the CD-ROM, which contains a single session which consists of a (mostly 
mode 1) data track. Another popular CD format is the Audio-CD, which consists of a single session of 
audio tracks. There are several other defined CD formats like Mixed Mode or Multisession CDs. Mixed 
Mode CDs consist of several data tracks of the same kind (either all mode 1 or all mode2/XA) written in 
separate track at once sessions. Such CDs may be created by Nero.

All these CD formats are well defined and can be read by nearly every CD-ROM drive. As mentioned 
before there are some other CD formats, which are unspecified. For example it´s not a good idea to 
mix mode 1 and mode2/XA tracks on the same CD. Another illegal CD format may be created by writing 
some audio tracks followed by an ISO mode 1 track and then to write some other audio tracks behind the 
others. Such CDs can not or can only partially be read by most CD-ROM drives. Many CD recorders can´t
write additional tracks on such CDs. Mostly likely they panic and throw lots of SCSI/IDE errors instead 
(especially „illegal request“ errors).

It would be nice in this context to be warned if an unspecified CD format could be written before it´s too 
late. Indeed Nero offers this feature. It may be turned on or off in Nero´s preference property sheet. This 
option is called Check for correct CD format before burning. If this option is activated, then Nero will 
show you an alert box if you´re about to create an unspecified CD format. You can either abort the burn 
process or ignore Nero´s warning. As mentioned before there is no guarantee, that unspecified CD-ROM 
formats can be written on any CD-ROM drive.



Creating an Image File
Processing of an image file consists of two independent steps. 

· In the first step, the image file is created and saved as a file instead of being written immediately onto 
a CD. 

· In the second step, this image file is written onto a CD. 

1. Select Image Recorder from the CD-RECORDER> Choose Recorder menu and confirm your 
selection by clicking on OK.

2. Create a CD-ROM (ISO) or an Audio-CD compilation.

3. Open the Write dialog. The easiest way to do this is to click on the Write CD icon in the toolbar You 
will then go to the Write CD dialog box, which will undoubtedly look familiar to you: it is the same box 
which you saw for the creation of a new compilation, only now the Burn property sheet is shown on 
the top. You will see several boxes, some of which are already selected. Determine maximum 
speed and Simulate are already selected. In the case of an image file, however, it is enough to only 
select the Write box. You can deactivate the other steps by clicking on them. 

4. You may now check over all of the settings on this and the other property sheets and make any 
necessary changes. 

5. You may now confirm your selections by clicking on the 
Write button. The Save Image File dialog box opens. Here, you can enter a file name for the image 
file. The files of your compilation will be written into this file. In other words, you need as much space 
for the image file as the total size of the files of the compilation. 



Writing the Image File
1. If you wish to write a previously-created Image File (refer Creating an Image File) 

select File> Write CD-Image from the menu. The Open list box will open and display the existing 
NRG files (image files) for you. 

2. Select the file you wish from the list and confirm your selection with the Open command. You will then
go to the Write CD dialog box, and the Burn property sheet will be shown on top. 

From here, the procedure is the same as for writing a CD-ROM (ISO) or an Audio-CD compilation. 
You will see several boxes, of which some have already been selected. Determine maximum speed 
and Simulate are already selected, and you may now also select Write.

All of the preferences may now be examined and changed if necessary. 

3. You may now confirm your selections by clicking on the 
Write button. All of the selected steps will now be carried out in sequence including the burn process. 
So that you can follow exactly what is happening, a status window is displayed in which the individual 
steps are listed. As a last step, you will see a message like "Burn process was successful with 2x 
(300 KB/s)." Finally, the CD will be ejected. 

4. You may now check to see for yourself what was written onto your CD by re-inserting the CD and 
clicking on the CD-Info icon. 



CD-Copy with Nero
You can choose between two methods if you want to copy a CD.

1. The image copy: the original CD will be read from the recorder and Nero will then create and save an 
image file, with the contents of your CD, to e.g. your hard disk. In a third step, Nero writes the image 
file onto a blank CD.

2. The copy on-the-fly. Nero will read directly from your CD-ROM drive and write to your recorder, 
without creating an image file on your hard disk

It's hard to give general advice on when to use „on the fly“ and when to use „image copy“. The following 
list can give you some hints:

Choose „image copy“ if you

1. want the best possible reproduction (especially concerning audio tracks)

2. have enough time for an image copy which takes somewhat longer than an „on the fly“ copy

3. have enough free space on a harddisk to store the CD image (you will possibly need several hundred 
megabytes!)

4. want to write multiple copies of a CD

5. expect read errors on the source CD (for example if you can see scratches or dust on the disc)

6. want to copy mixed mode (a data track and one or more audio tracks) CDs. This is because some 
CD-ROM drives have a unholy tendency to „hang up“ (that means they don´t respond any longer to 
SCSI/DIE commands most likely crashing your computer) while reading blocks between the data and 
the audio track of a mixed mode CD. If this happens while an „on the fly“ copy takes place your 
destination CD will be crushed by a buffer underrun.

Choose „on the fly“ copy if you

1. don´t have much time

2. don´t have enough free space on your harddisk (hint: 1 minute of audio takes about 10 MB and a CD 
image file may be several hundred MB long!)

3. want to copy a CD-ROM (no audio tracks) and trust the error correction capabilities of your CD-ROM 
drive

4. want to copy mixed mode (a data track and one or more audio tracks) CDs and are pretty sure (by 
experience?) that your CD-ROM drive will read audio tracks perfectly and won´t „hang up“ (see 
above) between the data and audio track of a mixed mode CD

5. don´t care if audio index positions get lost

6. have lots of empty CD recordables J    
7. Nero versions 3.0 or higher are capable of burning „on the fly“ copies using a CD-ROM drive as input

device. You don´t need several hundred megabytes of free volume space on your harddisk any longer
and will be able to copy CDs much faster. That´s the good news.

CD-Copy step by step

More about Copy on-the-fly

Checking the audio features of your CD-ROM drive





CD-Copy step by step
We will show you, step by step, how you use Nero to copy a CD. 

We will leave all the options with their default settings. For detailed information, please refer to the 
Reference Chapter in the manual. The manual is on the Nero-CD in the form of an Acrobat document.

Follow the instructions carefully. Good luck!

1. Click on the CD-Copy icon in the New Compilation dialog window which opens after you start Nero. 
If you have already opened Nero, you can reach this dialog window through the icon for "New 
Compilation".

On the property sheets, the Burn card is on the top.

2. Click on the property sheet Copy options to select the copy method you want.

3. Insert the original CD in your recorder or in your CD-ROM drive, depending on whether you have 
selected the copy on-the-fly method or the "image-copy" method.

4. By clicking on the CD Copy button, the Write CD dialog box will open..

5. Now you may confirm by clicking on the Copy CD button. All of the selected steps will now be carried 
out in sequence including the burn process. So that you can follow exactly what is happening, a 
status window is displayed in which the individual steps are listed. 

6. As a last step, you will see a message like "burn process was successful with 2x(300 KB/s)".

7. Finally, the CD will be ejected.

8. You may now check to see for yourself what was written onto your new CD by re-inserting the CD and
clicking on the CD info icon.

CD-Copy with Nero

More about Copy on-the-fly

Checking the audio features of your CD-ROM drive



More about Copy on-the-fly
Nero versions 3.0 is capable of burning „on the fly“ copies using a CD-ROM drive as input device. You 
don´t need several hundred megabytes of free volume space on your harddisk any longer and will be able
to copy CDs much faster. That´s the good news.

The dark side of the moon.....

Being able to copy CDs faster without needing lots of free volume space on your hard disk sounds like 
very good news. But unfortunately things are not that easy. There are several things to consider before 
copying „on the fly“:

1. You need a CD-ROM drive capable of reading input data quickly enough to burn a CD. This 
means if you want to burn with 2x then your CD-ROM drive must be able to read faster than 2x (better
4x or more) to prevent a „buffer underrun“. To make sure this won´t happen is not so simple. One 
problem is that lots of CD-ROM drives (even brand new models among them!) read audio data 
considerably slower than normal data (mode 1 or mode 2) For example there are some 24x CD-ROM 
drives which read audio slower than 3x.

Even more problems cause CD-ROMs which can´t read audio at all or can only read audio 
slower than 1x (even brand new models!). Of course this makes „on the fly“ copies of audio or 
mixed mode CDs impossible because every CD recorder needs input data at at least 1x (depending 
upon the selected write speed).

2. If a read error occurs on the source CD (for example if there is a scratch on the CD), then the read 
error may not be corrected by reading a sector several times because there´s no time to repeat the 
read process because every delay could cause a buffer underrun on the CD recorder of course 
trashing the unfinished copy. All that Nero can do in this case is to show a warning and write garbage 
data or just zeros to keep the recorder satisfied. The result will be a copy of the CD with some 
unreadable files which is better than a trashed CD but still pretty bad. That means that „on the fly“ 
copies are very sensitive concerning read errors.

3. Many CD-ROM drives can´t read any session information. All they can tell is how many tracks of 
which type were found on the CD. This means there may be a loss of session information.

4. Audio tracks may contain audio index positions. This information is available while reading the track 
that contains the index position. Unfortunately this is too late for „on the fly“ copies because recorders
want to know about audio index positions before starting to write the track. In the end this means that 
any audio index positions will be lost if copying „on the fly“. 

5. The last bad news concerns the quality of digitally read audiodata. To explain why it´s necessary to
discuss some technical details: While copying an audio track „on the fly“ Nero reads some audio data
and then writes it on CD. This action is repeated as often as necessary to copy the track. The result is
a very long repeated read/write/read/write... command sequence. Concurrently, the source and the 
destination CD keep spinning at independant speeds. The CD-ROM drive reads data from CD and 
stores it inside it´s cache memory. Nero will then receive it´s input data from the CD drive´s cache. If 
Nero reads digital audio data the procedure is just the same as for data. The trouble is that the source
CD drive normally should read faster than the recorder would write. So the CD-ROM drive fills it´s 
internal cache with „read ahead“ digital audio data to be able to respond quickly to read commands. 
Nero reads slower than the CD-ROM drive because it reads at the slower recorder´s speed. So at 
some point the CD-ROM drive´s cache is full (a so called „buffer overflow“) and some „old data“ 



(from the CD drive´s point of view) must be thrown away to be able to keep on reading ahead. But 
this „old data“ is from slower Nero´s point of view „current data“ and is urgently needed to be sent to 
the CD recorder. What the drive needs to do now is to seek to an earlier position of the audio track. 
Unfortunately, audio tracks consist of sectors which don´t contain any direct time information (data 
tracks do contain time information!). Therefore, what the CD-ROM drive does is to estimate a „rough 
guess“ of where the required audio data might be found on the CD. It then starts to read again at this 
„fuzzy“ position and fills it´s cache with data to send it to Nero. So the audio data Nero gets is not 
necessary exactly what Nero wanted to read, but may contain data from another (very close but not 
„correct“) position of the CD. Nero then uses this data to write it to the recorder believing the data is 
correct. The result is a copied track with some „clicks“ or „scratches“. This unwanted effect is 
called „jitter“. The amount of „jitter“ depends highly upon the model of your CD-ROM drives. There 
are drives which read audio perfectly and other produce such a huge amout of „jitter“ that they are 
almost impossible to use as input device for audio CD copies. To find out to which category your CD-
ROM drive belongs all you got to do is to save an audio track from your CD-ROM drive with Nero´s 
„Save track“ menu command and then play the wave file. If it sounds alright, then you´ve got a 
„good“ CD-ROM drive. If it sounds bad, then it´s better not to use this drive as input for „on the fly“ 
copies of audio or mixed mode CDs. By the way: for „image CD copies“ Nero can do „jitter 
correction“ to avoid scratches and clicks. While copying „on the fly“ there is no time to do that.

CD-Copy with Nero
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Checking the audio features of your CD-ROM drive
To read audio tracks as wave-files or to burn „on the fly“ CD-copies Nero has to read digital audio 
data from your CD-ROM drive. Please remember that reading digital audio data is something completely 
different from just „playing“ analog audio using headphones or a sound card! All CD-ROM drives can 
„play“ audio data, but only some can read digital audio data and among these only few read high quality 
audio data. You see, that the quality of the digitally read audio data may or may not be perfect. To be 
precise the audio quality is highly dependant upon the CD-ROM drive´s model and manufacturer.

What do we mean by „high quality“ audio data? This is easiest explained using an unpleaseant 
expample. There might be „discontinous“ audio data, which can be heard later as crackling noise or as a 
kind of „scratch“-sound. If you want to learn more about the technical reasons for this problem please 
read the section „On the fly“ copies using Nero“.

Before copying CDs or reading audio tracks as wave-files it might be a good idea to check the audio 
capabilities of your CD-ROM drive. This knowledge can help you to choose the best copy options and 
to avoid defect CD copies. To diagnose your CD-ROM´s audio capabilities please do the following steps:

1. Please check first, if your CD-ROM drive is already supported by Nero. You can do that by choosing 
the menu command CD Recorder->Audiodetect CD-ROM. If all combo boxes in the dialog appear 
dimmed and the only selectable button is „Cancel“, then your CD-ROM drive is supported by Nero. 
You can continue with step 2. If your CD-ROM drive appears in the list of unsupported CD-ROMs then
you need to do a CD-ROM autodetection first. Please read the section CD-ROM Autodetection for 
details.

2. Now put the Nero 3.0 CD into your CD-ROM drive. If the Nero installer launches, then stop the 
installation process because Nero is already installed.

3. Please choose the menu command Recorder->Save track. Select the second track (or the first audio
track) and save it as a wave file.

4. Create a new audio compilation by using the menu command File->New and drag the wave file you 
created in step 3 into the audio compilation.

5. Now doubleclick the wave track inside the audio compilation.

6. A dialog box will open allowing you to show the property page Set index positions. You should see a
graphical representation of the wave data on the screen with the two audio channels of the audio 
data. The upper (left) channel should look like a regular „ZigZag“-line (a „sawtooth“ curve to be 
precise) and the lower (right) channel should be a horizontal „zero“-line. You can use the right arrow 
button inside the audio scroll bar to scroll the audio data.

7. Taking a close look at the audio data should allow you to check, which of the following three 
descriptions is closest to your case:

· If you see a regular „ZigZag“-line at the left (upper) channel and a constant horizontal „zero“ line at 
the right (lower) channel, then your CD-ROM drive has high quality audio read capabilities. If your 
CD-ROM drive is able to read faster than 1x then you´ve got a really good CD-ROM drive. It may be 
used to copy all kinds of CDs „on the fly“. Congratulations! J

· If the lower (left) channel is constant zero but the „ZigZag“-line on the left (upper) channel appears to 
be irregular or as if somebody would have cut a piece of sound and pasted it somewhere else, then 
your CD-ROM drive suffers from „audio jitter“ (see chapter „On the fly“ copies using Nero“ for 



technical background info). Your CD-ROM drive may be used to copy CD-ROMs not containing audio 
tracks without problems. Copying audio or mixed mode CDs using your CD-ROM is a little bit risky 
and should be done with caution.

· If the „ZigZag“-Line sometimes appears at the left/upper channel and sometimes at the right/lower 
channel or if the audio data looks like „nonsense“ (for example both channels constant zero or if no 
„ZigZag“-line at all appears) then your CD-ROM drive unfortunately has pretty poor digital audio 
capabilities. In this case you shouldn´t use your CD-ROM to burn „on the fly“ copies of CDs 
containing audio tracks because the copies will almost surely be damaged. You can use our CD-ROM
to copy data CDs without expecting any trouble.

CD-Copy with Nero
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Saving audio tracks
An important prerequisite for creating Audio CDs with Nero is that the music files are available in WAV 
format with 44.1 kHz and 16-bit stereo.

1. Insert an Audio CD in your recorder

2. Now select the CD recorder>Save track menu

3. All the information concerning your CD will be displayed in the Save track window: tracks, length,... 

4. Select the track you which to save as a Wav-file and press the Save as a wavfile button. The Save as 
window opens.

5. Input now the name under which these sound files should be stored. Default is track + chosen track 
number (from window) and „.WAV“. You can choose another name. :WAV will be added by NERO

6. After pressing the Save button, the Writing Wav file window opens. This window shows you the 
remaining time,    % completed and the succesful copy - or not.

7. If you want to save more audio tracks as Wav.file, please repeat steps four through six, otherwise 
press the Cancel button.

8. If the File Browser has not yet been opened, you can do that now by entering the VIEW>New File 
Browser command or by clicking on the File Browser icon.

Now you can create and burn your own Audio-CD.



Saving data tracks
The purpose of saving audio tracks into wave file is obvious. They can be used to create personal „best 
of“ Audio CDs. But Nero can store mode 1 data tracks too. The result will be a Nero CD imagefile which 
can be burned afterwards. But what the heck is this good for if the same effect can be achieved by 
copying files onto the harddisk and burning them later as an ISO compilation? Well, storing data tracks 
into an image file surely makes sense because it has some advantages compared with the more 
„traditional“ method of copying files and burning them as an ISO compilation:

1. You can store data tracks containing another file system than PC´s standard ISO! For example 
they could be Apple Macintosh HFS tracks or the so called „Hybrid CDs“ containing HFS and ISO 
data in a single track! The Macintosh information would be lost forever if files were burned as an ISO 
compilation. Saving the track and burning the resulting image file preserves all this additional data! 
The same argument is true for the „Apple ISO Extensions“ or the „Rockridge ISO Extensions“!

2. The Nero image files created by the command Save track can be burned on non-empty CDs. 
Furthermore the CDs don´t have to be fixated after burning! Both mentioned advantages together 
make it possible to create CDs containing all the information of several „small“ CDs (containing only 
some megabytes of data). Taking a look at some „silver CDs“ containing PC or Apple Macintosh 
software will show you, that most „silver“ CD ROMs are more or less „empy“ taking account of the 
fact that up to 640MB can be stored on a standard CD ROM. So why not combining several CDs on 
one writeable „golden CD“? Each „Sub-CD“ (or track) can be accessed easily from Windows through
Nero Multi Mounter. Enough theory. 

If you want to create such a „multivolume CD“ save all desired CDs as a Nero CD image file using 
the menu command Save track. Then burn them one by one onto a writeable CD. Those multivolume
CDs also have further important advantages compared with the CDs created by the „traditional“ 
method of copying CDs into folders and burning them all together as a single ISO compilation: There 
won´t be any file name collisions concerning the famous „Autorun.Inf“ and „Setup.exe“ files and even
those installers relying on a special volume name will do their job perfectly!

3. You possibly can copy multisession CDs which Nero normally can´t copy! The procedure is 
straightforward: copy all tracks into Nero image files using the method mentioned in point 2) of this 
text. Then burn them on an empty CD. Unfortunately there is a restriction for this method of copying 
multisession CDs: Those tracks containing links to other tracks may not be stored into a Nero CD 
image! The reason for this restriction is the fact, that images created from linked multisession tracks 
would not contain all referenced files and folders! So if you tried to burn such a track onto a different 
CD, everything would appear to be in perfect order until the very moment when you tried to read one 
of those files not contained in the original CD track. The result would be just read errors or junk data 
because the track link now would refer to some CD sector. To avoid these rather disastrous 
consequences storing of linked multisession tracks is generally prohibited in Nero.

Some information concerning the implementation of the Save track command in Nero: As first step Nero 
tries to analyze the data track to gather information about the file system stored in the selected data track.
Then, all CD sectors from this track are written into the Nero CD image file. Finally, the image file is 
processed to allow this image to be written onto a non-empty CD. For the experts among the Nero users: 
An ISO filesystem must be relocated if it is to be burned onto a different (non-zero) start sector of a CD. 
But don´t be afraid. Nero will do all this „dirty work“ for you.

Important Note: 



Nero can store ISO, Joliet, Macintosh HFS- and Hybrid (which is ISO and HFS) CD tracks into an image 
file. But if the image file (resp. the original CD track) contains a different file system unknown to Nero (like
native Unix filesystems or others) the result of burning this image onto a non-empty CD may be corrupted 
data. If it works or not depends on the kind of file system stored in the data track. For some file systems 
this might work and for others the result will just be corrupted data. But you can be sure to get correct 
results if the track contains one of the mentioned file systems: ISO, Joliet, HFS or Hybrid. Almost every 
available CD for PC or Apple Macintosh is created using these file systems. By the way: the kind of track 
is displayed in the track list dialog appearing after selecting the menu command Save track. If the track is 
showm as „Data mode 1“ without any further information, then Nero won´t be able to give any guaranties 
about the resulting CD. But Nero leaves you the freedom to decide whether you want to store those 
unknown tracks into a Nero image or not. Only an alert box is displayed to remind you of the risk.



Nero Multi Mounter
The Nero Multi Mounter, available for Win 95 und Win NT4.0, allows you to view ALL the sessions and 
to access ALL the files recorded on your Multisession CD!

The Nero Multi Mounter is automatically installed with the installation of Nero. 

How to use the Nero Multi Mounter?
1. Insert your Multisession CD into your CD-ROM drive or your recorder. 

2. Go to the Explorer and select the drive in which you put the CD.

3. Select properties either through the menu File/properties or by using the right mouse button. Then 
you will see two or more property sheets one of which is the volumes sheet. 

4. Select the volumes property sheet. You can see now all the sessions listed that have been burned 
onto the CD.

5. Click on the session you want to be displayed, then return to the Explorer. You can see now the 
contents of the selected session and select a file. 



Nero general questions
1. Does Nero burn on-the-fly?

2. How do I create a CD Image?

3. Although I created a Multisession disc I can only see the last session. Why?

4. After entering the serial number, I cannot get Nero installed . What is happening?

5. How can I prevent buffer underruns?

6. Although the speed test and the simulation have been tested successfully, I get a lot of error 
messages (SCSI-error, Host-Adapter-error,...) while burning

7. I can't select another language other than english. 



Yes, Nero automatically uses on-the-fly burning



To create a CD-image we use the so-called "image recorder". You select this recorder in the menu CD
Recorder>recorder selection. As a result, your files will be written into an image file and not directly 
to the recorder. To burn this image go to the menu File>Burn image. Remenber that you need 
enough free space on the chosen volume to save the full image.



If your CD Recorder supports multisession, you can only read the last session of your CD on 
Windows 95 and NT 4.0 and the first session on Windows 3.1x.

Nero gives you the solution: in Windows 95 and NT 4.0, you can use the Nero Multi Mounter to 
switch to any other session of your Multisession CD.

Please see also Nero Multi Mounter.



You most likely have a demo version of Nero installed, of which the time has expired. Please contact us 
for a new demo.



- defragment your hard disk from time to time

- no other tasks should be performed by the computer during the burn process

- before burning, you should always run the speed test and the simulation in order to get the optimal 
speed. If you don't do that, the maximum possible write speed of the recorder is kept as default.



The problem seems to be a communication problem between the recorder and the SCSI host adapter. To 
solve it, you have to change the BIOS settings of your SCSI host adapter. Please press Ctrl+A during 
booting up your PC to enter the "SCSI Select Utility". Then select "Configure/View Host Adapter Setting" 
and "SCSI Device Configuration". In this menu change the following parameters of the SCSI ID you have 
connected your recorder:

Initiate Sync Negotiation: No

Maximum Sync Transfer Rrate: 5 or 10



Nero provides three languages: english, german and french.

If you can only select one language in the Language property sheet, please reinstall Nero and follow 
carefully the instructions as they appear. You will then have the option to select all languages supported 
by Nero.



Operating system specific questions
1. Windows 95

There are no known operating system specific problems

2. Windows NT 4.0

· I don't have a Winaspi for NT. Where do I get it?

Please contact the manufacturer of the SCSI-Adapter you are using to get the latest version.

· I don't find the Nero Multi Mounter, when I select the properties in the Explorer

On NT some system specific files can only be installed by the admnistrator of your PC. This also 
applies to the Mounter. Please ask your System Admnistrator to install Nero again under his login.

3. Windows 3.1x

· I don't have a Winaspi for 3.1x. Where can I get it?

Please contact the manufacturer of the SCSI-Adapter you are using to get the latest version.



Recorders supported by Nero
· Yamaha CDR-100, CDR-102, CDR-400, CDR-200, CDR- 401, CRW-4001, CRW-4260

· Sony CDU-920, CDU-924, CDU-926, CDU-928

· Philips (IMS) CDD-2000, CDD-2600, CDD-3610

· HP HP 4020i, HP 6020i, HP 7100

· Teac CD-R50S, CD-R55S

· Pinnacle RCD 4X4

· Ricoh RO-1420C, MP-6200S, MP-6201S, MP-6211S, MP-6200A

· Plextor PX-R24CS, PX-R412C

· Mitsumi CR-2201CS, CR-2401TS

· Pioneer DWS-114X

· JVC XR-W2010, XR-W2020, XR-W2022

· Nomai 680 RW

· Optima CD-R 1300

· Plasmon CDR4240, CDR480R

· Panasonic CW-7501, CW-7502



SCSI-Adapters supported by Nero
· Adaptec AHA 1505, AHA 1520, AHA 1542 CP, AHA 2920, AHA 2940, AHA 3940W

· AdvanSys ABP-930

· Aresys AP-500

· Bus Logic Flash Point LTKT-930

· CMD CSA-6520

· Dawicontrol CD-2974

· EXSys EX-2021, EX-2201

· Initio INI-9100

· Symbios Logic Sym 8150S



Context-sensitive Help
This version of Nero offers you comprehensive context-sensitive help as the first level of online-help. 

If you need help or more information about a certain topic in Nero you just 

-    click on the icon        (for context-sensitive help), then 
-    click on the topic. As a result 
- the help window will be opened showing more details about the selected topic.
If you press F1 you also get context-sensitive help about the active object (the object that has the 
focus on it). This is a deviation from the Windows standard but nevertheless useful.

In Windows 95 & WINDOWS NT 4.0 it is also possible to get help about objects (e.g. icons) that are not 
activated with either the        icon or F1.



Support provided by ahead
Home page: http://www.ahead.de

E-Mail: support@ahead.de

Address: ahead software gmbh, im stoeckmaedle 6, 76307 karlsbad, germany

Fax: ++49 724 891 1888

Please contact us if you have any technical question or problem with Nero. Don't forget to state basic 
information which helps us upfront to evaluate your request:

· Model of your computer:

· Operating system (including revision number): 

· Processor:

· RAM:

· Version of Nero and serial number:

· Other premastering software installed?:

· Model of your SCSI Adapter:

· Winaspi.dll (model/revision number):

· Wnaspi32.dll (model/revision number):

· apix.vxd only for Win 95

· atapi.sys only for Win NT

· For Win NT: Aspi32.dll (model/revision number):

· Bios-revision number:

· Model of your recorder:

· Firmware version of your recorder:

· Hard disk (IDE or SCSI?):

· Please describe the problem you had:



Confirm your selection and leave this window with OK.



Discard your selection and leave this window with Cancel.



General options which apply to all windows of Nero.

You can define that Nero

- always starts with a new CD-Compilation. 

- always starts with a Nero File Browser. 

To activate these options please immediately restart Nero.

The Windows 95 Shell Icons can be turned on and off without restarting Nero.      *A4.1*



If the option Start with new compilation is activated, Nero will always display the dialogue for new CD-
Compilation when it is started.      *A4.2*



If the option Start with File Browser is activated, Nero will always display a File Browser Window when it
is started.      *A4.4*



If the Shell Icons are actived you will get the Windows Shell Icons for all files. If you deactivate this option
you will get simplified icons only. Data access might be faster with simplified icons.

This option applies to Windows 95 only.      *A4.3*



If you have made changes on the property sheet/s and want to leave this dialogue press OK. All changes 
will be saved.



If you have made changes and now decided that you want to cancel them, press Cancel.



If you have made changes on the upmost property sheet and want    to save and activate them 
immediately, press Apply.



Settings for the Nero-cache. 

With this cache you can optimize the dataflow for the burnprocess of the CD: Especially if you have a 
majority of small files it is likely that the burn process gets interrupted with the result of a ruined CD that is
not even readable any more.    

The continuous supply of files can also be limited through other influences like high CPU load or a highly 
frequented network. If you have more than one hard disk installed you should put the cache on the faster 
one.     *A5.1*



Path where you want to put the Nero-Cache.      *A5.2*



Path where you want to put the Nero-Cache.      *A5.3* 



You can select where you wish to put your cache if you don't agree to the preselected suggestion.      
*A5.4*



This drive/s of your hard disks will be tested on access speed.     *A5.5*



This is the result of the speed test     *A5.6*



Free capacity on tested drive/s.     *A5.7*



If your computer has more than one drive you should test which is the fastest drive to put your cache onto
it. 

Network drives are not considered in this test as they normally are not suitable for caching.     *A5.8*



Press this button to start the speed test.      *A5.9*



You can reserve a minimum of space that won't be touched by the cache you defined in this dialogue. Up 
to this size the cache is allowed to use all free disc space on your harddisk.     *A5.10*



Enter the number for the minimum of reserved space here (in MB).      *A5.11*



Measurement for the minimum of untouched space.      *A5.12*



Enter abbreviations for strings that are used in the files and folders of your compilation to replace the 
original strings.      *A6.1*



Enter the string to be replaced here.      *A6.2*



Enter the replacement/abbreviation here.      *A6.3*



Enter the string to be replaced here.      *A6.4*



Enter the replacement/abbreviation here.     *A6.5*



This listbox shows the already entered strings and their replacements.     *A6.6*



Enter a string and its abbreviation and press Insert. The text will be added to the list of abbreviations 
below. Already existing strings and abbreviations will be rejected.      *A6.7*



Select a string and its abbreviation in the listbox. Press Delete. The text will disappear from the list of valid
abbreviations.      *A6.8*



If you want to replace an existing abbreviation with a new value you have to either enter the original string
and the new abbreviation in the data entry field or simply select the existing string in the list. Then press 
Change. The old abbreviation will be replaced with the new one.      *A6.9*



You can select a language for Nero from this list of available languages. 

The active language is highlighted. Nero-text will be displayed in this language, system dialogues will 
always be displayed in the language of your operating system. 

If you want to change the language please close all Nero windows first.      *A7.1*



List of available languages. 

The active language is selected. Nero-text will be displayed in this language, system dialogues will 
always be displayed in the language of your operating system. 

If you want to change the language you    first have to close all Nero windows.      *A7.2*



Recorder Selection

Here you find all a list of connected recorders and the image recorder with detailed information about 
them. 

! The recorders must be turned on before you start Nero.

The image recorder allows you to save your compilation to an image file that can be used later.     *B1.1*



Here you see a list of all connected recorders and the image recorder. If you select this recorder the 
compilation will be saved to an image file that can be used later. You will get prompted to enter a 
filename.

! The recorders must be turned on before you start Nero.    *B1.2*



This column shows the assigned SCSI-IDs for the recorders.    *B1.3*



This column shows the names of the assigned adapters. Should you need to check on their assignments 
go to the Device Manager in System Properties.     *B1.4*



This column shows the numbers of the assigned adapters. Should you need to check on the installed 
adapters and their assigned SCSI-devices go to the Windows System Options.      *B15*



List of available Recorders

Here you find all a list of connected recorders and the image recorder with detailed information about 
them. 

Select the recorder you would like to connect and confirm with OK.     

Note: The image recorder allows you to save your compilation to an image file that really contains all files
and folders of your compilation. Make sure you have enough disk space. This image file can be used 
later. 
So if you want to create an image file you do the same as if you would write to a real recorder, just that 
the output is routed to a file. 
Later if you decided to burn that file to a CD you use the menu File/Burn Image.

! The recorders must be turned on before you start Nero.      *B1.6*



More information about the selected recorder. 

! The recorders must be turned on before you start Nero.     *B1.7*



The maximum write speed of the selected recorder.      *B1.8*



The maximum write speed of the selected recorder.      *B1.9*



The firmware revision number of the recorder.      *B1.10*



The firmware revision number of the recorder.      *B1.11*



With Disc-At-Once - a special writing mode - all tracks will be written to the CD without the usual 2 
second gaps in between. Not all recorders do support this mode.      *B1.12*



With Disc-At-Once - a special writing mode - all tracks will be written to the CD without the usual 2 
second gaps in between. Not all recorders do support this mode.     *B1.13*



This recorder supports simulating the write process.     *B1.14 *



This recorder supports simulating the write process.      *B1.15*



After you have selected a recorder confirm and leave this dialogue with OK.



If you want to cancel your selection or don’t want to make any changes use Cancel to leave the dialogue.



CD Info Dialogue

This dialogue gives you detailed information about the inserted CD (in the recorder).     *B2.1*



This icon tells you which kind the format or type the inserted CD. *B2.0*



Type (format) of the inserted CD.      *B2.2*



Type (format) of the inserted CD.      *B2.3*



Kind of CD, e.g. a CD-Recordable.      *B2.4*



Kind of CD, e.g. a CD-Recordable.      *B2.5*



Total capacity of the inserted CD in MM:SS.Frames (minutes, seconds, 1/75 Sec) and size in MB.      
*B2.6*



Total capacity of the inserted CD in MM:SS.Frames (minutes, seconds, 1/75 Sec).      *B2.7*



Total capacity of the inserted CD in size in MB.     *B2.8*



Available capacity of the inserted CD in MM:SS.Frames (minutes, seconds, 1/75 Sec) and size in MB.    
*B2.9*



Available capacity of the inserted CD in MM:SS.Frames (minutes, seconds, 1/75 Sec).      *B2.10*



Available capacity of the inserted CD in MB.      *B2.11*



Number of existing sessions.      *B2.12*



Number of existing sessions. Each compilation creates another session. The minimum size of each 
session is one track, but a session can have more than one track.     *B2.13*



Number of written tracks. The maximum number of tracks on a CD is 99.      *B2.14*



Number of written tracks. The maximum number of tracks on a CD is 99.      *B2.15*



Sorry, not yet supported.     *B2.16*



Sorry, not yet supported.     *B2.17*



Sorry, not yet supported.     *B2.18*



Sorry, not yet supported.     *B2.19 *



Existing sessions. Each compilation creates another session. The minimum size of each session is one 
track, but a session can have more than one track.      *B2.21*



Listnumber of tracks over all sessions. The tracks can be of a different type e.g. Audio-CD-tracks, CD-
ROM-tracks etc.      *B2.22*



Shows the type of the track like Audio or Data.      *B2.23*



Starting position of the tracks, measured in MM:SS.Frames (1/75 Sec.).      *B2.24*



Ending position of the track, measured in MM:SS.Frames (1/75 Sec.).      *B2.25*



Length of the track, measured in MM.SS.Frames (1/75 Sec.).      *B2.26*



Size of the track in MB.      *B2.27*



Listing of all written tracks and sessions on this CD with summary lines per session.     *B2.28*



Press this button to eject the CD.    *B2.29*



If you changed the inserted CD it might be necessary to do a refresh to display the actual data of this CD.
*B2.30*



If you want to leave this dialogue press OK. *B2.31*



If you choose (by clicking) an Audio track in the window, you get the option to choose only this title, to 
save it temporary and to add further titles from other Audio's, too. So you can burn your own Audio. When
an Audio-track in the above window is selected it will be saved as a WAV-file when button is pressed. 
Here you input the name under which these sound files should be stored. Default is track + chosen track
number (from window) and „.WAV“. You can choose another name. :WAV will be added by NERO. If you
save your Audio files the following windows will show you the remaining time,    % completed and the 
succesful copy - or not.      *B2.32*



Burning your compilation

On this property sheet you find all steps of the burn process:

- the test on access speed

- a simulation of the burn process, and 

- the burn process itself

- and the finalization of the CD. 

Also you can set cache options for Nero to optimize the write speed. 

Details about the steps are displayed in their associated help. If you want to copy a CD there are naturally
no features to modify. *D1.0*



This speed test accesses the files and folders of your compilation and finds the slowest source speed.    If
the default write speed of the recorder is faster than the determined slowest source speed, the recording 
speed will be automatically adjusted to the lower value.     *D1.1*



Here you choose the steps you would like to run one after the other until the final write and finalize step.
You can also run the steps one by one, but we rather recommend to run them in a row. Only then the next
step will take over the results of the last step. 

Example: You run the speed test and the simulation, the determined speed is 2x. At a later point you run 
the write step separately without running the other two steps (speed test and simulation) again. In this 
case the default write speed of the recorder will be used, and this might in many cases be a faster one 
than the determined speed. It is very likely that this write process leads into a buffer underrun.      *D1.12*



The simulation does a check on several technical aspects of the CD burning process, e.g. if the CD is 
ready, already finalized etc. The complete burn process is simulated. the only difference to the read time 
burn process is that the laser is turned off. The simulation won't change the CD.     *D1.2*



If the simulation ran successfully and you checked the box for Write, the CD will be written (actually 
‘burned’) with the same speed. If you want to copy a CD it will finalized automatically. *D1.3*



If you check this box as well, the CD will be finalized, i.e. you can’t write further sessions onto this CD. If 
you want to copy a CD it will finalized automatically. *D1.4*



Here you can change the write speed. But normally you should run the speed test and a simulation 
before actually writing the CD, so you get the right speed put into this field automatically. If you have 
renounced these prior tests, the maximum possible write speed of the recorder is put into this field as 
default. 

! Once as speed has been tested successfully you should not change it to a faster value as this might 
lead into errors.     *D1.5*



The maximum possible write speed of the recorder is put into this field as default. You can change this 
write speed. 

Normally you should run the speed test and a simulation before actually burning the CD, so you get the 
right speed put into this field automatically. If you renounced these prior tests the maximum possible write 
speed of the recorder is kept in this field as default. 

! Once a speed has been tested successfully you should not change it to a faster value as this might lead
into errors.     *D1.7*



If you enter a number other than 1 the compilation will be written to that number of CDs. You have to 
insert one CD after the other.     *D1.6*



If you enter a number other than 1 the compilation will be written to that number of CDs. You have to 
insert one CD after the other.     *D1.8*



These options provide the use of a cache for critical files and folders to ensure a constant flow of data 
during the write process. If you select one or both of these options the files concerned will be put to a 
cache before the other steps of the write process start. 

In the Nero PREFERENCES on the property sheet Cache you can define which drive you wish to utilize 
for caching. If you want to copy a CD there are naturally no options to modify.      *D1.13*



If your compilation contains files or folders from a slow network or on the floppy disk it is useful to write 
these files to a cache. If you select this option these files will be put to a cache before the other steps of 
the write process start. 

In the Nero PREFERENCES on the property sheet Cache you can define which drive you wish to utilize 
for caching. If you want to copy a CD there are naturally no options to modify  *D1.9*



The default for this option is set to ON, because this cache is very likely to speed up your write process 
and makes it more secure.

In the Nero PREFERENCES on the property sheet Cache you can define which drive you wish to utilize 
for caching. If you want to copy a CD there are naturally no options to modify    *D1.10*



If your compilation contains lots of small files the access time will probably be much longer than with a 
few bigger files. Therefore we recommend that you use this cache for small files up to a certain size to 
increase the chances of a continuos write process. If you select this option these files will be put to a 
cache before the other steps of the write process start. If you want to copy a CD there are naturally no 
options to modify  *D1.11*



Enter the number for a filesize here (in KB). All files smaller than this size will be cached. If you want to 
copy a CD there are naturally no options to modify    *D1.11*



General information about the contents of the active compilation (selected files and folders to be burned 
on the CD), the total size, data structure etc.      *D3.0*



Size of selected object/s in bytes.      *D3.3*



Size of selected object/s in bytes.      *D3.4*



Number of files and folders of the selected item.      *D3.5*



Number of files and folders of the selected item.      *D3.6*



This is the date when the selected object was created.     *D3.7*



This is the date when the selected object was created.      *D3.8*



This is the date of the last change of the selected object.     *D3.9*



This is the date of the last change of the selected object.     *D3.10*



Notes if this compilation has ever been written.      *D3.11*



Notes if this compilation has ever been written.      *D3.12*



If you choose this options the file won’t be visible on your CD. 

If you have more objects selected and at least one object is marked as hidden, the checkbox will appear 
grey.      *D3.13*



You can select the priority in what order files will be written onto the CD. There are three values 
available. The default is Low.      *D3.14*



You can select the priority in what order files will be written onto the CD. There are three values 
available. The default is Low.      *D3.15*



This dialogue New Compilation consists of three main parts:

On the left side you select the type of CD you want to burn, e.g. 

a CD-ROM
an Audio-CD or
a CD-Copy.

In the middle part the upmost property sheet is about dataoptions, relating to the type of CD you 
selected. All these options can be modified at a later stage if necessary. (For your information: In the 
copy-mode there are naturally no options.)

On the right side you can confirm your selection/s by 

using „New“ or 
using „Enter“ or 
using „CD-Copy“ or
using „Cancel“ or 
using „Open“ at an already existing compilation. 
(Open is naturally not possible at „CD-Copy“ because all the items of the original-CD will be copied.....).   
*D3.16*



On the left box you select the type of CD you want to burn, e.g. 

Ø          a CD-ROM (ISO)or
Ø        a CD-ROM (boot) or

Ø        a CD-ROM (Hybrid) or

Ø        an Audio-CD or

Ø        a Mixed Mode CD or    

Ø        a CD-Copy with Mixed Mode CDs, Video CDs, Audio CD, CD-ROM

„CD-Copy“ copies all informations without possibility of changing any data. 

! An indication to the „copyright“ will appear if data are protected. 
            In this case it is only allowed to copy these data for your own.

If you are missing the copy icon in the box "new compilation" you have to choose your real recorder - but 
not the image recorder. Please start your recorder everytime before starting Windows.

You see different document types here: 

- if you are in the FILE> NEW dialogue 
you can select whether you would like to create an CD-ROM or an Audio-CD

- if you are in the FILE> COMPILATION INFO dialogue or 

- if you are in the FILE> WRITE CD dialogue 
you see the icon for the chosen CD-format of your compilation

- if you are in the FILE> BURN IMAGE dialogue 
the icon for CD-Image is displayed.        *D3.17*



This button can have two different values:

If it says Open you leave this dialogue and the Open Dialogue will prompt you to select an already 
existing compilation.

If it says CD-Info you are in Burn CD Dialogue. At this stage it might be interesting to check your inserted 
CD again. Press CD-Info and you get to the CD-Info Dialogue.        *D3.18*



Volume Descriptor 

Most of this section is for advanced users. 

The volume label is the only value that is a must. All others are optional and therefore left blank as 
default. 

You can save information about the CD (respective session) that will be saved in the volume descriptor. 
The volume descriptor is found on the beginning of each session and contains the datastructure and other
optional information like publisher, a copyright note etc. 

The volume descriptor uses special charactersets that are defined in the ISO 9660 Standard. ISO 9660 is 
the international standard for the logical data structure on a CD-ROM. ISO 9660 defines amongst other 
things the allowed charactersets:

Ø The a-characters comprise

capital letters from A to Z, 

digits from    0 to 9, and 

the following special characters: "&!%´)(=*+,-/:;><?_. (blank) 

Ø The d-characters comprise 

capital letters from A to Z, 

digits from    0 to 9, and 

the special character _ (underscore)

You find more information about charactersets in the Nero-manual.      *D2.0*



Volume label of the CD (respective session) 

If you start a new compilation the default value is New. 

You should change this name as it is used in the compilation Info and later on the CD as its name. 
Maximal length is 32 characters of the d-characterset.

The d-characters comprise capital letters from A to Z, digits from    0 to 9, and the special character _ (underscore).

! Should you change the characterset at a later stage it is possible that some characters get converted 
(e.g. the German Umlaut Ä will be converted to AE), resulting in a longer filename that possibly exceeds 
the allowed length according to the ISO Standard. 
In this case the rule is: The first four characters remains untouched. Starting from the fifth character the 
amount of characters that exceed the allowed length will be cut out. E.g. a conversion of the filename 
börning_rom.txt in ISO level 1 results in BOER_ROM.TXT.      *D2.17*



Volume label of the CD (respective session) 

If you start a new compilation the default value of the volume label is New. You should change this name 
as it is used in the compilation Info and later on the CD as its name. Maximal length is 32 characters of 
the d-characterset.

The d-characters comprise capital letters from A to Z, digits from    0 to 9, and the special character _ (underscore).

! Should you change the characterset at a later stage it is possible that some characters get converted 
(e.g. the German Umlaut Ä will be converted to AE), resulting in a longer filename that possibly exceeds 
the allowed length according to the ISO Standard. 
In this case the rule is: The first four characters remains untouched. Starting from the fifth character the 
amount of characters that exceed the allowed length will be cut out. E.g. a conversion of the filename 
börning_rom.txt in ISO level 1 results in BOER_ROM.TXT.     *D2.18*



Optional entry about the operating system on which the CD will be used. 
Max. 32 characters of the a-characterset.

The a-characters comprise capital letters from A to Z, digits from    0 to 9, and the following special characters: "&!%´)(=*+,-/:;><?_.
(blank). 

! Should you change the characterset at a later stage it is possible that some characters get converted 
(e.g. the German Umlaut Ä will be converted to AE), resulting in a longer filename that possibly exceeds 
the allowed length according to the ISO Standard. 
In this case the rule is: The first four characters remains untouched. Starting from the fifth character the 
amount of characters that exceed the allowed length will be cut out. E.g. a conversion of the filename 
börning_rom.txt in ISO level 1 results in BOER_ROM.TXT.     *D2.1*



Optional entry about the operating system on which the CD will be used. 
Max. 32 characters of the a-characterset.

The a-characters comprise capital letters from A to Z, digits from    0 to 9, and the following special characters: "&!%´)(=*+,-/:;><?_.
(blank). 

! Should you change the characterset at a later stage it is possible that some characters get converted 
(e.g. the German Umlaut Ä will be converted to AE), resulting in a longer filename that possibly exceeds 
the allowed length according to the ISO Standard. 

In this case the rule is: The first four characters remains untouched. Starting from the fifth character the 
amount of characters that exceed the allowed length will be cut out. E.g. a conversion of the filename 
börning_rom.txt in ISO level 1 results in BOER_ROM.TXT.     *D2.2*



Optional name of a set of CDs to create a logical unity.
Max. 128 characters of the d-characterset.

The d-characters comprise capital letters from A to Z, digits from    0 to 9, and the special character _ (underscore).

! Should you change the characterset at a later stage it is possible that some characters get converted 
(e.g. the German Umlaut Ä will be converted to AE), resulting in a longer filename that possibly exceeds 
the allowed length according to the ISO Standard. 
In this case the rule is: The first four characters remains untouched. Starting from the fifth character the 
amount of characters that exceed the allowed length will be cut out. E.g. a conversion of the filename 
börning_rom.txt in ISO level 1 results in BOER_ROM.TXT.     *D2.3*



Optional name of a set of CDs to create a logical unity.
Max. 128 characters of the d-characterset.

The d-characters comprise capital letters from A to Z, digits from    0 to 9, and the special character _ (underscore).

! Should you change the characterset at a later stage it is possible that some characters get converted 
(e.g. the German Umlaut Ä will be converted to AE), resulting in a longer filename that possibly exceeds 
the allowed length according to the ISO Standard. 
In this case the rule is: The first four characters remains untouched. Starting from the fifth character the 
amount of characters that exceed the allowed length will be cut out. E.g. a conversion of the filename 
börning_rom.txt in ISO level 1 results in BOER_ROM.TXT.     *D2.4*



Optional name of the publisher of this CD. 

You can either enter 
- a string with max. 128 characters of the a-characterset or
- a filename. The filename must start with underscore ( _ ) and follows the 8+3 rule. The a-characterset 
applies to the filename including underscore and period. The file must be placed in the root directory of 
the CD.

The a-characters comprise capital letters from A to Z, digits from    0 to 9, and the following special characters: "&!%´)(=*+,-/:;><?_.

(blank). 

! Should you change the characterset at a later stage it is possible that some characters get converted 
(e.g. the German Umlaut Ä will be converted to AE), resulting in a longer filename that possibly exceeds 
the allowed length according to the ISO Standard. 
In this case the rule is: The first four characters remains untouched. Starting from the fifth character the 
amount of characters that exceed the allowed length will be cut out. E.g. a conversion of the filename 
börning_rom.txt in ISO level 1 results in BOER_ROM.TXT.     *D2.5*



Optional name of the publisher of this CD. 

You can either enter 
- a string with max. 128 characters of the a-characterset or
- a filename. The filename must start with underscore ( _ ) and follows the 8 + 3 rule. The a-characterset 
applies for the filename including underscore and period. The file must be placed in the root directory of 
the CD.

The a-characters comprise capital letters from A to Z, digits from    0 to 9, and the following special characters: "&!%´)(=*+,-/:;><?_.

(blank). 

! Should you change the characterset at a later stage it is possible that some characters get converted 
(e.g. the German Umlaut Ä will be converted to AE), resulting in a longer filename that possibly exceeds 
the allowed length according to the ISO Standard. 
In this case the rule is: The first four characters remains untouched. Starting from the fifth character the 
amount of characters that exceed the allowed length will be cut out. E.g. a conversion of the filename 
börning_rom.txt in ISO level 1 results in BOER_ROM.TXT.     *D2.6*



Optional name of the person who prepared the data for this CD. 

You can either enter 
- a string with max. 128 characters of the a-characterset or
- a filename. The filename must start with underscore ( _ ) and follows the 8 + 3 rule. The a-characterset 
applies for the filename including underscore and period. The file must be placed in the root directory of 
the CD.

The a-characters comprise capital letters from A to Z, digits from    0 to 9, and the following special characters: "&!%´)(=*+,-/:;><?_.

(blank). 

! Should you change the characterset at a later stage it is possible that some characters get converted 
(e.g. the German Umlaut Ä will be converted to AE), resulting in a longer filename that possibly exceeds 
the allowed length according to the ISO Standard. 
In this case the rule is: The first four characters remains untouched. Starting from the fifth character the 
amount of characters that exceed the allowed length will be cut out. E.g. a conversion of the filename 
börning_rom.txt in ISO level 1 results in BOER_ROM.TXT.     *D2.7*



Optional name of the person who prepared the data for this CD. 

You can either enter 
- a string with max. 128 characters of the a-characterset or
- a filename. The filename must start with underscore ( _ ) and follows the 8 + 3 rule. The a-characterset 
applies for the filename including underscore and period. The file must be placed in the root directory of 
the CD.

The a-characters comprise capital letters from A to Z, digits from    0 to 9, and the following special characters: "&!%´)(=*+,-/:;><?_.

(blank). 

! Should you change the characterset at a later stage it is possible that some characters get converted 
(e.g. the German Umlaut Ä will be converted to AE), resulting in a longer filename that possibly exceeds 
the allowed length according to the ISO Standard. 
In this case the rule is: The first four characters remains untouched. Starting from the fifth character the 
amount of characters that exceed the allowed length will be cut out. E.g. a conversion of the filename 
börning_rom.txt in ISO level 1 results in BOER_ROM.TXT.     *D2.8*



Optional name of the application (if used) that prepared the data for this CD. 

You can either enter 
- a string with max. 128 characters of the a-characterset or
- a filename. The filename must start with underscore ( _ ) and follows the 8+3 rule. The a-characterset 
applies for the filename including underscore and period. The file must be placed in the root directory of 
the CD.

The a-characters comprise capital letters from A to Z, digits from    0 to 9, and the following special characters: "&!%´)(=*+,-/:;><?_.

(blank). 

! Should you change the characterset at a later stage it is possible that some characters get converted 
(e.g. the German Umlaut Ä will be converted to AE), resulting in a longer filename that possibly exceeds 
the allowed length according to the ISO Standard. 
In this case the rule is: The first four characters remains untouched. Starting from the fifth character the 
amount of characters that exceed the allowed length will be cut out. E.g. a conversion of the filename 
börning_rom.txt in ISO level 1 results in BOER_ROM.TXT.     *D2.9*



Optional name of the application (if used) that prepared the data for this CD. 

You can either enter 
- a string with max. 128 characters of the a-characterset or
- a filename. The filename must start with underscore ( _ ) and follows the 8 + 3 rule separated by a 
period (.). The a-charactersets applies for the filename including underscore and period. The file must be 
placed in the root directory of the CD.

The a-characters comprise capital letters from A to Z, digits from    0 to 9, and the following special characters: "&!%´)(=*+,-/:;><?_.

(blank). 

! Should you change the characterset at a later stage it is possible that some characters get converted 
(e.g. the German Umlaut Ä will be converted to AE), resulting in a longer filename that possibly exceeds 
the allowed length according to the ISO Standard. 
In this case the rule is: The first four characters remains untouched. Starting from the fifth character the 
amount of characters that exceed the allowed length will be cut out. E.g. a conversion of the filename 
börning_rom.txt in ISO level 1 results in BOER_ROM.TXT.      *D2.10*



Optional copyright note. 

You can enter a filename that follows the 8 + 3 rule. The a-characterset applies including underscore and 
period. The file must be placed in the root directory of the CD.

The a-characters comprise capital letters from A to Z, digits from    0 to 9, and the following special characters: "&!%´)(=*+,-/:;><?_.
(blank). 

! Should you change the characterset at a later stage it is possible that some characters get converted 
(e.g. the German Umlaut Ä will be converted to AE), resulting in a longer filename that possibly exceeds 
the allowed length according to the ISO Standard. 
In this case the rule is: The first four characters remains untouched. Starting from the fifth character the 
amount of characters that exceed the allowed length will be cut out. E.g. a conversion of the filename 
börning_rom.txt in ISO level 1 results in BOER_ROM.TXT.      *D2.11*



Optional copyright note. 

You can enter a filename that follows the 8 + 3 rule. The a-characterset applies including underscore and 
period. The file must be placed in the root directory of the CD.

The a-characters comprise capital letters from A to Z, digits from    0 to 9, and the following special characters: "&!%´)(=*+,-/:;><?_.
(blank). 

! Should you change the characterset at a later stage it is possible that some characters get converted 
(e.g. the German Umlaut Ä will be converted to AE), resulting in a longer filename that possibly exceeds 
the allowed length according to the ISO Standard. 
In this case the rule is: The first four characters remains untouched. Starting from the fifth character the 
amount of characters that exceed the allowed length will be cut out. E.g. a conversion of the filename 
börning_rom.txt in ISO level 1 results in BOER_ROM.TXT.      *D2.12*



Optional file that contains an abstract of the contents of the CD.

You can enter a filename that follows the 8 + 3 rule separated by a period (.). The a-charactersets applies 
including underscore and period. The file must be placed in the root directory of the CD.

The a-characters comprise capital letters from A to Z, digits from    0 to 9, and the following special characters: "&!%´)(=*+,-/:;><?_.
(blank). 

! Should you change the characterset at a later stage it is possible that some characters get converted 
(e.g. the German Umlaut Ä will be converted to AE), resulting in a longer filename that possibly exceeds 
the allowed length according to the ISO Standard. 
In this case the rule is: The first four characters remains untouched. Starting from the fifth character the 
amount of characters that exceed the allowed length will be cut out. E.g. a conversion of the filename 
börning_rom.txt in ISO level 1 results in BOER_ROM.TXT.     *D2.13*



Optional file that contains an abstract of the contents of the CD.

You can enter a filename that follows the 8 + 3 rule. The a-characterset applies including underscore and 
period. The file must be placed in the root directory of the CD.

The a-characters comprise capital letters from A to Z, digits from    0 to 9, and the following special characters: "&!%´)(=*+,-/:;><?_.
(blank). 

! Should you change the characterset at a later stage it is possible that some characters get converted 
(e.g. the German Umlaut Ä will be converted to AE), resulting in a longer filename that possibly exceeds 
the allowed length according to the ISO Standard. 
In this case the rule is: The first four characters remains untouched. Starting from the fifth character the 
amount of characters that exceed the allowed length will be cut out. E.g. a conversion of the filename 
börning_rom.txt in ISO level 1 results in BOER_ROM.TXT.     *D2.14*



Optional file that contains bibliographic information if needed.

You can enter a filename that follows the 8 + 3 rule. The a-characterset applies including underscore and 
period. The file must be placed in the root directory of the CD.

The a-characters comprise capital letters from A to Z, digits from    0 to 9, and the following special characters: "&!%´)(=*+,-/:;><?_.
(blank). 

! Should you change the characterset at a later stage it is possible that some characters get converted 
(e.g. the German Umlaut Ä will be converted to AE), resulting in a longer filename that possibly exceeds 
the allowed length according to the ISO Standard. 
In this case the rule is: The first four characters remains untouched. Starting from the fifth character the 
amount of characters that exceed the allowed length will be cut out. E.g. a conversion of the filename 
börning_rom.txt in ISO level 1 results in BOER_ROM.TXT.      *D2.15*



Optional file that contains bibliographic information if needed.

You can enter a filename that follows the 8 + 3 rule. The a-characterset applies including underscore and 
period. The file must be placed in the root directory of the CD.

The a-characters comprise capital letters from A to Z, digits from    0 to 9, and the following special characters: "&!%´)(=*+,-/:;><?_.
(blank). 

! Should you change the characterset at a later stage it is possible that some characters get converted 
(e.g. the German Umlaut Ä will be converted to AE), resulting in a longer filename that possibly exceeds 
the allowed length according to the ISO Standard. 
In this case the rule is: The first four characters remains untouched. Starting from the fifth character the 
amount of characters that exceed the allowed length will be cut out. E.g. a conversion of the filename 
börning_rom.txt in ISO level 1 results in BOER_ROM.TXT.     *D2.16*



The property sheet Data Options contains three main parts:

- In the first part you select the ISO 9660 Standard Level (1 or 2)

- in the middle part you can choose a characterset other than only ISO.

- the third part offers some options to allow some relaxation of the strict ISO standard rules.     *D4.0*



In File- and Directorynames Length you choose the ISO 9660 Standard Level to be used for this CD. 

ISO Level 1 allows only 8+3 characters in uppercase for a filename. The only special character allowed is
underscore ( _ ). Directory names may not include extensions. 

Default is Level 2 that allows a maximum of 31 characters.

Nero converts all files and folders automatically according to this selection.     *D4.5*



ISO Level 1 restricts:

- the directory name to max. 8 characters

- the filenames to max.    8 characters followed by a period and an extension with 3 characters (8+3 rule).

Consider if you use Windows 3.x or DOS. In this case we recommend to select this level. If you use 
Windows 95, Level 2 gives you better possibilities. 

But in the end it always depends on the host that will run the CD.     *D4.1*



ISO Level 2 allows

- max. 31 characters for the directory name as well as the filename.

Consider if you use Windows 95. In this case we recommend to select this level. If you use Windows 3.x 
or DOS, you rather select Level 1. 

But in the end it always depends on the host that will run the CD.     *D4.2*



Select a characterset. 

In addition to the ISO 9660 possibilities Nero allows ASCII and DOS. If you select DOS you get e.g. the 
special language characters like the German Umlaut. For more detailed information please refer to the 
manual.    *D4.10*



The default selection for a characterset is ISO 9660.      *D4.3*



If you wish to use the DOS characterset please click here. For more detailed information please refer to 
the manual.      *D4.4*



If you wish to use the ASCII characterset please click here. For more detailed information please refer to 
the manual.      *D4.7*



If the Microsoft defined "Joliet" (only for Windows NT and Windows 95!, -other operating systems (e.g. 
MAC) are not in the position to use it ) is activated, second parallel complete directory structure in 
UNICODE is created. It is    important to know the receiver of the CD. In "Joliet", file and directory names 
are allowed up to 64 characters long. There are no restructions in directory depth, the typeface is 
extended. (The (first) ISO 9660 directory structure is created according to the ISO-9660-Standard. In the 
case that no Joliet rule is applicable, the ISO-9660-Standard takes precedence. For exact Joliet 
information see: Joliet CD-ROM Recording Specification/ISO 9660:1988, Extension for UNICODE, 
Version 1, May 22, 1995. Contact address: Microsoft Developer Relations Group.      *D4.11*



You can relax the strict ISO standard for the pathdepth. 

This will increase the speed of the complete burn process, but your compilation won’t be tested whether 
it meets the standard. For more information regarding this checkbox refer to the manual.      *D4.6*



Allow a pathdepth of more than 8 levels. If you don’t select this option, the maximum of 8 levels 
(according to the ISO Standard) will be used. You can check on your pathdepths and levels of hierarchy 
with the Nero File Browser or the Explorer.

! Only if you don’t selected this option your data will be checked. In case of more than 8 levels you will 
be prompted for further actions.      *D4.8* 



Allow more than 255 characters in a filename including its path. If you don’t select this option, the 
maximum of 255 characters (according to the ISO Standard) will be used. You can check on your 
filename with the Nero File Browser or the Explorer. 

! Only if you don’t select this option your data will be checked. In case of more than 255 characters you 
will be prompted for further actions.      *D4.9*



What’s the status of your burn process?

This dialogue appears after you have selected and confirmed the actions on the Write CD dialogue. 

Depending on the selections made in the middle part you see a listbox showing the status of all steps and
their results. The %-bar tells you the progress of the active step..     *D5.1* 



You can cancel the process by clicking on Cancel. 

The actual burn process is excluded from this possibility, as we don’t want you to ruin your CD by 
interrupting a already started burn process. 



Date- and time-settings of the files and folders of your compilation are displayed here. If needed they 
can be modified.     *D7.0*



Information about the dates of the files and folders of the compilation.      *D7.15*



In this row the date and time of the creation of the compilation are displayed.     *D7.3*



The date of the creation of the compilation.     *D7.4*



The time (of the date in the field next to this one) of the creation of the compilation.     *D7.5*



In this row the date and time of the last change of the compilation are displayed.      *D7.6*



The date of the last change of the compilation.      *D7.7*



The time (of the date in the field next to this one) of the last change of the compilation.      *D7.8*



Date and time can be set when the CD will be effective i.e. can be read. In depends though on the future
operating system, whether this option is applied or not.      *D7.9*



Enter a date when the CD will be effective.     *D7.10*



Enter a time (of the date in the field next to this one) when the CD will be effective.     *D7.11*



Until this date and time the CD can be read.      *D7.12*



Until this date the CD can be read.      *D7.13*



Until this time (of the date in the field next to this one) the CD can be read. In depends though on the 
future operating system, whether this option is applied or not.      *D7.14*



The files of the compilation should be written with the following dates.      *D7.16*



Select this option if you want to keep the original file date and time. This is the default.      *D7.17*



Select this option if you want to change the original file date and time to todays’ date and time.      
*D7.18*



Select this option if you like to choose another file date and time for the files of your compilation.     
*D7.19*



Enter the new date here..    *D7.1*



Enter the time for the date you entered here.     *D7.2*



Enter the new date here.      *D7.20*



Enter the time for the date you entered here.     *D7.21*



This button will change its value as follows: 

- If the button value is New you are in the FILE> NEW dialogue    A new compilation window will be 
opened according to the selections you made in this dialogue. 

- If the button value is OK you are in the FILE> COMPILATION INFO dialogue. You confirm the options 
that are set for the actual compilation. If you just made changes to these options they will be saved.

- If the button value is either 
                            Speed Test, 
                            Simulate or 
                            Write 
                            CD-Copy
... you are in the FILE> WRITE CD dialogue.    
The button tells you which option you selected. Write can either write to the CD-R or to an image file, 
depending on the selection you made in CD-Rekorder/Choose Recorder.    
If you selected more than one option it will display the value of the last option. 

!!! Copy CD
In the Copy-mode the upper button will change to „CD-Copy“.
„Open“ is naturally not possible at „CD-Copy“ because all the items of the original-CD will be copied......
The index card „burn“ appears.      *D3.16/*D7.22*



If you decided to leave this dialogue without saving the changes you just made use Cancel.      *D7.23*



This dialogue allows you to search on files and folders in your compilation.      *E1.1*



This is the Find Icon.    *E1.0*



You can search files and folders in your compilation by 

Name:
enter a filename or string of the name you want to search for.

Size (in KB):
is smaller or equal, or is larger or equal means that you search Files compared to this filesize.

File:
written - not written can be searched on as a flag.      *E1.2*



Select a criteria according to the first choice of your find statement.      *E1.3*



Enter a string of the filename you would like to find.    *E1.4*



Respect upper/lower case?      *E1.5*



You start the search process by clicking on Find.      *E1.6*



You can cancel the search process by clicking on Cancel.        *E1.7*



Neros main menu bar. 

This menu bar follows the Windows terminology, -keys and -symbols. 

You can open any menu by clicking on it or use the key combination Crtl + underlined character. 

To open a submenu you can use the key combination Crtl + underlined character or you can enter the 
underlined character of the submenu name in case the main menu is already pulled down.     *M1.0*



New command (File menu)

If you click on FILE> NEW a new CD-compilation will be started. 

The property sheet Data Options will be presented upmost where you choose the data format and 
characterset. 

You can select if you would like to prepare a CD-ROM, an Audio-CD or CD-Copy by just clicking on their 
symbols.    *M1.1*



Compilation Info command (File menu)

If you click on FILE> COMPILATION INFO the property sheet Info will appear where you see details 
about the compilation like the total size, the date of creation etc. 

You can also select one of the other sheets of the property page at any time to check or change options.   
*M1.6*



Refresh Compilation command (File menu)

This command will update your compilation under the following condition:

If in the original place files and folders have been added to a folder you used in the compilation, this folder
will be updated with the new files.  This does not apply for deleted files. A refresh is always done 
automatically if you open an existing compilation.      *M1.7*



Write CD command (File menu)

If you click on FILE> WRITE CD the property sheet Burn will appear where you select the steps for 
testing the process until the final writing and finalizing of the CD. 
This is also where you create an image file that can be burned later if you selected the image recorder in 
the menu CD-Recorder/Choose Recorder. 

Here again you can check and change all options set for this compilation on the other property sheets.      
*M1.8*



CD Copy (File new)

CD Copy (from the menu File new) will show you the box for copying a whole CD. By pressing it appears 
the index card for copying. *M1.80* 



Burn Image command (File menu)

If you click on FILE> BURN IMAGE the open dialogue will appear where you can select an existing 
image file and burn it to a CD-R. 

Note: To create an image file please follow these steps:
- Select the image recorder in the menu CD-Recorder/Choose recorder. 
- Create your compilation with drag and drop.
- Go to the menu File/Write CD and click on the option Write. Confirm with the Write button.    You will be 
asked to enter a file name for this image file.      

This image file contains real copies of the selected files and folders, therefore needs the same amount of 
space as the original files.      *M1.81*



Preferences command (File menu)

If you click on FILE> PREFERENCES you set your default options for Nero like e.g. the language or the 
Nero-cache. 

These options apply to all windows of Nero. For some options you need to do a restart, which is indicated
on their property sheets and in the help.      *M1.9*



Select all command (Edit menu)

This function selects all files and folders of the active window.     *M2.6*



Delete command (Edit menu)

With this command you can delete files and folders from the compilation.      *M2.5*



Invert Selection command (Edit menu)

If you have some files and folders already selected, this function reverses the active selection.      *M2.7*



Properties command (Edit menu)

The result of this command changes depending on the active object.

If the File Browser or a compilation window is active you get summarized information about all files and
folders of either window. 

If you have a certain file or folder selected, you get more detailed information, e.g. you can set the 
priority for the write process of a file here.     *M2.8*



Add File command (Edit menu)

This is another comfortable possiblity to add files to your compilation. The standard Open dialogue will be 
presented on which you can search and select files, which then will be added to the active compilation.      
*M2.9*



Create Folder command (Edit menu)

Should you need to reorganize your compilation it is likely that you need new folders. With this function a 
new folder is inserted which has the name New by default. Should you like to change this name just 
double-click on New and you can enter it.      *M2.10*



Find command (Edit menu)

You can search files in your active compilation using different criteria like a string of the filename etc.     
*M2.11*



File Browser command (View menu)

Actually opens a Nero-File Browser.      *M3.3*



Original command (View menu)

If you choose this view your files and folders in the compilation will be displayed with their original names 
the same way as they are displayed in the operating system.      *M3.4*



ISO 9660 command (View menu)

You can display the files and folders of the compilation according to the selected    characterset for 
conversion - ISO 9660, DOS or ASCII. 

More detailed information about the rules for conversion can be found in the manual.     *M3.5*



By Name command (View menu)

The files and folders of your compilation will be displayed in alphabetical order. *M3.6*



By Type command (View menu)

The files and folders of your compilation will be displayed in an alphabetical order of the type of file. Only 
applicable in the File Browser.      *M3.7*



By Size command (View menu)

The files and folders of your compilation will be displayed according to their size. Only applicable in the 
File Browser.      *M3.8*



By Date command (View menu)

The files and folders of your compilation will be displayed according to their date of creation. Only 
applicable in the File Browser.      *M3.9*



By Position command    (View menu)

The files and folders of your compilation will be displayed in the original order, you could also call this 
unsorted. Only applicable in the File Browser.      *M3.10*



Choose Recorder command (CD-Recorder menu)

Opens a selection window with all connected recorders. 

! If you select the image recorder, your compilation will be written to an Image-File.      *M4.1*



CD-Info command (CD-Recorder menu)

Here lots of useful information about the inserted CD is displayed.      *M4.2*



Eject CD command (CD-Recorder menu)

If you need to eject the CD manually.      *M4.3*



Help Topics command (Window menu)

Shows the available online-help.      *M6.1*



Main window of Nero.

You can open as many CD- and File Browser windows here as you need.. 

Use the following menus: 

FILE> NEW or

FILE> OPEN, and for the File Browser

VIEW> NEW FILE BROWSER

or the corresponding icons in the taskbar.



The Nero File Browser.
You now have activated the Nero File Browser. 

This File Browser follows the functionality of the Windows Explorer very closely. You can view the 
hierarchy of all files you would like to access, and you can simply use drag & drop to move files and 
folders from the File Browser into your compilation . 



Audio-CD-Compilation
You are now in an Audio-CD-Compilation.    

Audio files to be burned to a CD have to meet the CD-quality (44,1 kHz and 16 bit stereo), and they have 
to be in the dataformat .WAV.

Again use drag & drop to move them into your compilation. These Audio files can even be played here if 
your PC is equipped with a sound card and speakers. 

Use FILE> WRITE CD to continue with writing the CD.    *AU1.0*



CD-ROM Compilation
You are now in a CD-ROM compilation.    

Use drag & drop to move any kind of datafile into this compilation. 

Use FILE> WRITE CD to continue with writing the CD.



Assuming that you have a soundcard and loudspeakers or a headphone you can select one or more 
audio tracks and play them by pressing Play.    *AU1.1*



Press here to Stop the rendering.    *AU1.2*



Displays the length of the selected and running audio track in minutes:seconds:frames.      *AU1.3*



Displays the length of the selected and running audio track in minutes:seconds:frames.      *AU1.4*



Displays the number of the selected and running audio track.      *AU1.5*



Displays the number of the selected and running audio track.      *AU1.6*



The pathdepthtest checks your compilation whether

- it has more than the allowed 8 levels of the ISO 9660 standard, or whether

- it has more than 255 characters in a filename including the path.    

You will be prompted for further action according to the options you choose.      *P0*



Explanation for the path test.      *P1*



This listbox displays a path (or more) that either

- has more than the allowed 8 levels or

- has more than 255 characters in a filename including the path.     *P2*



The result of the pathtest is, that one of the two cases was found in the hierarchy of your compilation. 

If you don’t want to allow a relaxation of the ISO 9660 Standard you have to click on this option. The 
process will then be stopped here to give you the opportunity to rearrange your data.      *P3*



If you agree to relax the ISO 9660 Standard in this case press this button.    The chosen process will be 
continued.      *P4*



Nero tests the system option Auto insert notification which automatically notifies you if you 
change/insert a CD. If this option is active we suggest to turn it off, as a notification during the burn 
process will very likely cause an interrupt on the data flow to the CD-writer, which might lead into a ruined 
CD.      *I1*



Please follow the information on the screen.      *I3*



Please follow the information on the screen.      *I4*



If Nero is not installed with the driver NEROCD95.VXD you can install NEROCD95.VXD by activating this
button + OK. Windows will be restarted, automatically. The button can't be activated, if the driver can't be 
found on the CD (why??). Than it is grey. *I4.1*



If you agree to turn the Auto insert notification off now please select this option. The option will be 
changed automatically and Windows will be restarted to apply the change immediately.      *I5*



If you prefer to exit Nero to e.g. check the system options yourself then select this option.      *I6*



If you don’t agree to turn the Auto insert notification off, select this option. 

! Please be aware that this options can cause an interrupt in the burn process and therefore might 
lead to a ruined CD.      *I7*



Confirm your selection with OK.      *I2*



Personalize your copy of Nero!

Please enter your name, company and serial number here. You find the serial number in the packaging of
Nero.     *L1*



Here we would like to give you some historical information about Nero, and the ‘burning’ Coliseum of 
Rome, which you see as our program icon :

It is important for us to mention that Nero who was emperor from 54 - 68 AD, according to our historians, 
has most likely not burned Rome but was accused for it in 64. 

The Coliseum has not existed at his time because it was built 72 - 82 AD. It is also not known whether it 
has ever been burned down. 

But somehow it is public opinion that Nero had something to do with burning Rome, and the Coliseum is 
only in very few cases known as a symbol for Paris or Ittersbach, so...J          *L2*



Please follow the information on the screen.      *L3*



Please enter your name here. No rules apply.      *L4*



Please enter your name here. No rules apply.      *L5*



Please enter the name of your company here. No rules apply.      *L6*



Please enter the name of your company here. No rules apply.      *L7*



Please enter your serial number here. You find the serial number in the packaging of Nero. Don’t forget 
the hyphens.     *L8*



Please enter your serial number here. You find the serial number in the packaging of Nero.  Don’t forget 
the hyphens.      *L9*



Confirm your entries with OK.      *L10*



If you don’t want to continue entering your personal data here you can select Exit to leave Nero.      
*L11*



This property sheet displays information about all tracks of your compilation.      *AI1.0*



Total size of all tracks in MM:SS.Frames (minutes:seconds.1/75 Sec.) and MB.      *AI1.1*



Total size of all tracks in MM:SS.Frames (minutes:seconds.1/75 Sec.) and MB.      *AI1.3*



Total number of tracks/files and folders in this compilation.     *AI1.4*



Total number of tracks in this compilation.      *AI1.5*



Here you can enter more details about your Audio-CD. 

Please note that at the moment they won’t be put onto the CD but will be stored with your compilation for 
later reference.     *AI2.0*



You can enter a title for your CD here. 

Please note that at the moment they won’t be put onto the CD but will be stored with your compilation for 
later reference.      *AI2.1*



You can enter a title for your CD here. 

Please note that at the moment they won’t be put onto the CD but will be stored with your compilation for 
later reference.      *AI2.2*



You can enter one or more artists of the CD here. 

Please note that at the moment they won’t be put onto the CD but will be stored with your compilation for 
later reference.     *AI2.3*



You can enter one or more artists of the CD here. 

Please note that at the moment they won’t be put onto the CD but will be stored with your compilation for 
later reference.      *AI2.4*



You can enter a copyright note for CD here. 

Please note that at the moment they won’t be put onto the CD but will be stored with your compilation for 
later reference.      *AI2.5*



You can enter a copyright note for the CD here. 

Please note that at the moment they won’t be put onto the CD but will be stored with your compilation for 
later reference.      *AI2.6*



You can enter the producers’ name of the CD here. 

Please note that at the moment they won’t be put onto the CD but will be stored with your compilation for 
later reference.      *AI2.7*



You can enter the producers’ name of the CD here. 

Please note that at the moment they won’t be put onto the CD but will be stored with your compilation for 
later reference.      *AI2.8*



You can enter the European Product Code of the CD here (if available). 

Please note that at the moment they won’t be put onto the CD but will be stored with your compilation for 
later reference.      *AI2.9*



You can enter the European Product Code of the CD here (if available). 

Please note that at the moment they won’t be put onto the CD but will be stored with your compilation for 
later reference.      *AI2.10*



Enter the date when the UPC is valid.    *AI2.11*



Enter the date when the UPC is valid.    *AI2.12*



You can enter a comment about the CD. 

Please note that at the moment they won’t be put onto the CD but will be stored with your compilation for 
later reference.      *AI2.13*



You can enter a comment about the CD. 

Please note that at the moment they won’t be put onto the CD but will be stored with your compilation for 
later reference.     *AI2.14*



Shows icon for the selected object (e.g. a compilation, file or folder).      *AI2.15* 



Shows when the object was added to the compilation.      *AI2.16*



Shows when the object was added to the compilation.      *AI2.16*



Shows the path of the selected object.      *AI2.17*



Shows the path of the selected object.      *AI2.17*



Displays the name of the selected object.      *AI2.18*



Displays the original path of the selected object.      *AI2.19*



Displays the original path of the selected object.      *AI2.19*



Confirm your selection with OK.      *AI2.20*



If this file is a system file it is marked with    ü.      *AI2.21*



If the attribute a for archive is set for this file it is marked with    ü.      *AI2.22*



If this file is write protected it is marked with    ü.     *AI2.23*



The listed attributes can be modified.      *AI2.25*



Size of the image file.      *F1*



Size of the image file.      *F2*



Path and name of the image file.      *F3*



Path and name of the image file.    *F4*



Number of tracks.     *F5*



The track has the displayed format.    *F6*



Size of the track.     *F7*



List of tracks of the image file.     *F8*



This property sheet displays information about all tracks of your image file. *F9*



According to the Image-File „Disk at once“ is activated (ü) or not. You can change it. The advantage of 
DAO (ü) is the better quality and the higher speed of burning. Nero recommends activating the DAO 
feature when burning an Audio CD. *F10*



You may use the writing mode "multisession", for example for incremental backups. A multisession CD 
allows files and folders not only to be recorded in different sessions at different times, until the CD is full, 
but also to be appended, deleted, and rewriten only if they have been changed. 

If all the options in this property sheet are disabled, please make sure that you have not chosen the 
image recorder or that your recorder has been turned on before starting the operating system. 

This property sheet contains two main parts

- in the first part you define if you want to create a new multisession CD, to add new sessions to your CD 
or simply write a CD-ROM (ISO).

- in the second part you can activate options for your compilation.

You may leave all the options with their default settings. Confirm your selection by clicking on the New 
button. The Select track window will open. *G11*



Please select this option, if you want to create a multisession CD from a blank disc or from a CD you have
already started to record. In this case, the resulting CD will be a ISO CD with additional multisession 
information.*G12*



If you have already started recording a multisession CD and just want to continue the disc, please select 
this option. You may now activate the options of the second part of this property sheet to define whether 
files and folders should be added, deleted or replaced during the automatic refresh.*G13*



If you just want to record a ISO CD-ROM, please select this option. *G14*



Nero will replace the files existing on your CD, depending on which options you have activated: archive 
bit set, file date or length, or file content. *G15*



Each file has, under Windows, an archive bit, which is set by the operating system, if a file has been 
changed or modified. This bit is used by backup programms, which set the archive bit of a file to zero (0) 
each time it has been saved. If you activate the "archive bit" option , Nero will do the same. Therefore, 
this option is meaningful if you also use a backup programm.*G18*



Nero will only replace the files of which date or length have been modified.*G16*



This option is designed to compare, byte for byte, all the files recorded on your CD with the files in your 
operating system. Nero will automatically replace files if some differences have been detected. You may 
use this option if, for example, your computer displays an incorrect time.

Since every file will be read byte for byte, corrupted files on your CD will be also detected by Nero and 
replaced.*G17*



All the files and folders will be replaced, no matter if they have been changed or not. Since all files and 
folders will be physically rewriten, you may improve the reliablity of your backup. Disadvantage: you will 
loose space on your disc. However, from time to time, it might be useful to replace all files and 
folders.*G18*



If you activate the option, Nero will "delete" on your CD, files that don't exist anymore on your hard disc. 
They have been probably deleted since your last session. The pointer to these files's address will simply 
not be included in the directory of your new session: they seem to be erased. Only by using the Nero 
Multi Mounter you will be able to access them again, if you ever need them.*G19*



This option allows you to add, in your new session, files that have been recorded to your hard disc since 
your last session.*G20*



When activating this option, Nero will automatically display a dialog box with the refresh options before 
refreshing the compilation. *G21*



If you click on this option, your CD will be written with disc -at-once. If this option is not activated the CD 
will be recorded with with track-at-once.

For formats like Audio-CD, disc-at-once is more logical, since unnecessary pauses or "clicks" can be 
avoided. Track-at-once is generally used for multisession and ISO CDs.    *G22*



Here you can define the writing method. You have the choice between disc-at-once or track-at-once, 
depending on recorder capabilities. Please see recorder specific notes.

With disc-at-once the entire CD is written in one procedure, which allows more freedom for the recording
software, but at the same time prevents subsequent modifications. For formats like Audio-CD, disc-at-
once is more logical, since unnecessary pauses can be avoided. Disc-at-once is also recommended for 
master CDs which will be manufactured.

With track-at-once every track is written separately allowing the CD to be recorded in several sessions 
at a later time, until the CD is full. Therefore, pauses are unavoidably created between the tracks. You 
may be able to modifie the pause lengh, though. It depends on recorder capabilities. Track-at-once is 
generally used for multisession and ISO CDs.



Please select the track that contains the files and folders you whish to back up. It will normally be the last 
ISO track. 

Confirm your selection by clicking on OK. The Multisession compilation window will open and will show 
the contents of the track you have just selected.

Important: Nero allows you to continue a multisession CD only, if all previous sessions have been 
recorded with Nero. If not, you will encounter an error message by confirming your track selection. *G23*



Here you can set options concerning the treatment of errors that might occure during the read process. 
*G24*



If Nero finds some read errors, how many times do you want Nero to read the CD, before giving up and 
treating the sectors as defect? Please enter a number between 1 and 5. *G25*



Nero will ignore unreadable data, and continue the read process. All the tracks will then be faithfully 
reproduced.



Nero will detect reading errors that might be caused by your recorder. Such errors might occur, for 
example, when audio data are not read by the recorder from the expected position. The results would 
then be a CD that does not perform well. *G26*



When Nero detects an error, the audio track will be rewound and read again. The reading process will 
slow down. This is the most reliable method to correct errors. *G27*



If you select this option, Nero will slow down the reading process only from the error's position. *G28*



Additional information like index positions will be provided during the read process. Audio indexes are 
required to determine the exact end of an audio track.

If this option is not checked, your Mixed-Mode    or Audio CD will be copied without any audio index 
positions. The audio tracks might be then stored on the CD with pauses in between. Therefore, we 
recommend not to select this option, if you want to copy a live CD.

If this option is checked, the index pauses will be also copied. The read process might be slower, 
depending on the recorder. *G29*



All the options will be displayed with their default settings. If you have activated some options and are not 
sure you were right, please click on the Set default button. *G30*



Here you can set advanced options for the correction of errors that might occure during the read process 
of an Audio- CD or an Audio track. *G31*



Here you can set options concerning the treatment of errors that might occure during the read process.

Before confirming your selection by clicking on Copy CD, make sure that all options needed in the 
property sheet Burn are also activated. 

If you click on Copy CD, the dialog box Write CD will open and the burn process will begin.

This property sheet contains two main parts

- in the first part you will find options for data tracks.

- in the second part you will find options for audio tracks. *G32*



If Nero finds some read errors, how many times do you want Nero to read the CD again , before giving 
up and treating the sectors as defect? Please enter a number between 1 and 10. *G33*



Here Nero will check for errors and notify you. The CD copying process will be aborted as soon as 
unreadable data has been found. Please check the contents of your CD and select the appropriate option 
again . *G34*



Nero will ignore unreadable data, and continue the read process. All the tracks will then be faithfully 
reproduced. *G35*



All sectors including EDC ( Error Detection Code) and ECC (Error Correction Code) information of your 
original CD will be read, allowing Nero to detect and correct corrupted data. The button can be disabled, 
disabled and checked, or enabled, depending on recorder capabilities. *G36*



When selecting the "try to correct data" option, Nero will use the EDC ( Error Detection Code) and ECC 
(Error Correction Code) information to correct sector errors. If your CD is copyrighted, we recommend not
to select this option.

When activating the "write uncorrected" option, corrupted data will be read and faithfully reproduced with 
all errors and corruption.

If your CD is copyrighted, we recommend to select this option. *G37*



All sectors including EDC ( Error Detection Code) and ECC (Error Correction Code) information of your 
original CD will be read, allowing Nero to detect and correct corrupted data. The button can be disabled, 
disabled and checked, or enabled, depending on recorder capabilities. 



When selecting the try to correct data option, Nero will use the EDC ( Error Detection Code) and ECC 
(Error Correction Code) information to correct sector errors. If your CD is copyrighted, we recommend not
to select this option.

When activating the write uncorrected option, corrupted data will be read and faithfully reproduced with 
all errors and corruption.

If your CD is copyrighted, we recommend to select this option. *G38*



All sectors including EDC ( Error Detection Code) and ECC (Error Correction Code) information of your 
original CD will be read, allowing Nero to detect and correct corrupted data. The button can be disabled, 
disabled and checked, or enabled, depending on recorder capabilities. 



When selecting the try to correct data option, Nero will use the EDC ( Error Detection Code) and ECC 
(Error Correction Code) information to correct sector errors. If your CD is copyrighted, we recommend not
to select this option.

When activating the write uncorrected option, corrupted data will be read and faithfully reproduced with 
all errors and corruption.

If your CD is copyrighted, we recommend to select this option. *G39*



When selecting the try to correct data option, Nero will use the EDC ( Error Detection Code) and ECC 
(Error Correction Code) information to correct sector errors. If your CD is copyrighted, we recommend not
to select this option.

When activating the write uncorrected option, corrupted data will be read and faithfully reproduced with 
all errors and corruption.

If your CD is copyrighted, we recommend to select this option. *G40*



Additional information, such as audio index positions and the position of the end of an audio track, will be 
provided during the read process. These information are required to determine the exact end of an audio 
track

If this option is not checked, your Mixed-Mode    or Audio CD will be copied without any audio index 
positions. The audio tracks might be then stored on the CD with pauses in between. Therefore, we 
recommend not to select this option, if you want to copy a continuous playing CD.

If this option is checked, the index pauses will be also copied. The read process might be slower, 
depending on the recorder. *G41*



Nero will ignore unreadable audio tracks, and continue the read process. All the tracks will then be 
faithfully reproduced. *G42*



Nero will detect reading errors that might be caused by your recorder. Such errors might occur, for 
example, when audio data are not read by the recorder from the expected position. The results would 
then be a CD that does not perform well. *G43*



If you select the keep on reading option, Nero will slow down the reading process only from the error's 
position. This is the faster method but the less reliable method to correct errors.

If you select the rewind and read again option, Nero will rewind and read the audio track again. The 
second reading process will automatically be slower. This is the most reliable method to correct errors. 
*G45*



By exucuting CD Copy, Nero will read the original CD and save the contents to an image file . In a next 
step, the image file will be written to the CD.

Here you can choose which drive the image file should be written to. *G46*



Here you can choose which drive the image file should be written to.

Don't forget, that you need as much space for the image file as the total size of the tracks of the original 
CD. Depending on the CD, you might need up to 700 MB! *G47*



Click on this option, if you wish to create the same CD at a later time. The original CD will not be 
necessary anymore. You can use the same image file. *G49*



You will find information about the audio track you have selected.

This property sheet contains two main parts

- in the first part, the name of the audio file you have selected will be displayed

- in the second part you may change the track properties. *G50*



The name of the audio track you have selected is displayed. By default, it is the name under which you 
have saved it. *G51*



The name of the audio track you have selected is displayed. By default, it is the name under which you 
have saved it. *G52*



The name of the audio track you have selected is displayed. By default, it is the name under which you 
have saved it. *G52*



Here you can change the properties of the audio track you have selected. *G53*



Here you can rename the audio track you have selected. Confirm your selection by clicking on Apply or 
OK. *G54*



Here you can rename the audio track you have selected. Confirm your selection by clicking on Apply or 
OK. *G55*



Here you can set the pause length between two tracks to zero (0) or up to 873,5 seconds (or 65535 
frames). This option is very interesting, especially if your recorder doesn't support disc-at-once: 
unnecessary pauses can be avoided. 

If you don't change the pause length, the audio tracks will automatically be stored on the CD with two 
seconds in-between. *G56*



Here you can set the pause length between two tracks in seconds or frames (75 frames=1 second). This 
option is very interesting, especially if your recorder doesn't support disc-at-once: unnecessary pauses 
can be avoided. 

If you don't change the pause length, the audio tracks will automatically be stored on the CD with two 
seconds in-between. *G57*



Here you can set the pause length between two tracks in seconds or frame (75 frames=1 second). *G58*



The ISRC (International Standard Recording Code) is a code to identify a CD track . ISRCs normally start 
with three characters follwed by 9 digits. For example, „ABC123456789“ would be a legal ISRC. This 
information will be written to a CD if ISRC codes are supported by your recorder.



The ISRC (International Standard Recording Code) is a code to identify a CD track . ISRCs normally start 
with three characters follwed by 9 digits. For example, „ABC123456789“ would be a legal ISRC. This 
information will be written to a CD if ISRC codes are supported by your recorder.



Each audio track has a copy protection bit which is turned on by default. Nero will show a ¤ character to 
remind you when you«re copying an audio track with its protection copy bit turned on. 



Each audio track has a copy protection bit which is turned on by default. Nero will show a ¤ character to 
remind you when you«re copying an audio track with its protection copy bit turned on.



Here you can input the type of the files you want to allow in your compilation. *G59*



Here you can input the type of files you want to allow in your compilation. 

e.g.: *.txt all existing files of TXT type will appear in your compilation. 

You also have the possiblity to enter multiple filters at once by separating them with semicolons; 

e.g: *.txt;*.xls;*.doc : all files of TXT, XLS and DOC type will appear in your 
compilation

*G60*



Here you can input the type of all files you don't want to allow in your compilation. *G61*



Here you can input the type of files you don't want to allow in your compilation. 

e.g.: *.txt all existing files of TXT type will not appear in your
compilation. 

You also have the possiblity to enter multiple filters at once by separating them with semicolons; 

e.g: *.txt;*.xls;*.doc : all files of TXT, XLS and DOC type will not appear in your compilation

*G60*



To correct read errors Nero uses a two step method: While reading audio tracks Nero will check, if the 
audio data is continous. If a discontinuity is detected, Nero will read the corresponding blocks again. Then
Nero tries to find matching audio blocks from previous and current audio data. If matching audio blocks 
can be found, these blocks are written to the CD.

The details of the algorithm to detect discontinouities are as follows: Nero calculates a (linear) prediction 
for the audio data to come. Afterwards Nero compares the audio data with it«s previous prediction. The 
difference between expected and detected audio data is then compared with a threshold, which can be 
entered in the dialog field Tolerance for continuity. Audio samples may have values from -32768 up to 
32767 (for 16 bit samples). Therefore the maximum threshold is 65336. The precision of the linear 
prediction is determined by the number of input samples Number of samples and the number of 
prediction coefficients Number of coefficients. The number of input samples must be greater than the 
number of coefficients.



If the first step of the jitter correction detects a discontinuity, then the second step is to try to correct the 
error. Nero will reread audio data before trying to find matching sectors by calculating the correlation 
between the audio samples. A high correlation means, that both sectors have „something in common“. A 
correlation of 1.0 indicates a perfect match. Nero again uses a threshold to determine if two sectors 
should be treated as identical. You can enter the treshold as percent in the dialog field Correlation 
tolerance. Again 100% indicates a perfect match.



The precision of the linear prediction is determined by the number of input samples (Number of 
samples) and the number of prediction coefficients (Number of coefficients). The number of input 
samples must be greater than the number of coefficients.



The precision of the linear prediction is determined by the number of input samples (Number of 
samples) and the number of prediction coefficients (Number of coefficients). The number of input 
samples must be greater than the number of coefficients.



Because these options can change the way Nero corrects audio data, modifications should only be done 
by an experienced user.

If you have made some changes and you are not sure, please press on the Set default button and you 
will get the default settings suggested by Nero.



This property page allows the definition of additional audio index positions. These audio index positions 
are recognized only by some (high quality) audio CD players and allow jumping to a defined position 
within an audio track. Note: The Windows 95 and NT audio CD player applications won´t be able to 
access audio index positions! L
Note: The Windows 95 and NT Audio CD Player applications are unable to access audio index positions. 
L



The oscilloscope style display can be used to watch audio data in a graphical style. Both stereo channels 
are shown as well as the current position within the audio track displayed as MSF (minutes, seconds and 
frames; one frame equals
1/75 of a second). Index positions are shown as red vertical bars. They can be created using the button 
New index. The right mouse button can be used to switch horizontal zooming.



This list shows the currently defined audio index positions. If you select an index position then the 
oscilloscope style display will show the corresponding audio samples. The selected audio index will be 
deleted if Delete index is clicked and it will be changed if Edit index is clicked. If you choose the Play 
button, then playing will start at this position.



The button New index can be used to create new audio index positions.

Notes:

Audio index positions are only supported by some recorders when in writing ‘track at once’ mode. If an 
audio compilation is burned as ‘disc at once’ then the audio index positions will definitively be written on 
CD.

Only some (high quality) audio CD players will be able to access additional audio index positions. The 
Windows 95 and NT audio CD player applications can not access audio index positions! L



This button starts playing the audio track from the currently selected audio index position. It will stop 
playing at the next index position or at the end of the audio track. Of course playing is possible only if you 
have a sound card.



This button allows editing of audio index positions as numerical values (MSF: minutes, seconds and 
frames; one frame equals 1/75 of a second).



This button will stop any audio playback.



The button Delete index permanently deletes the currently selected audio index position.



There are two methods to copy a CD with Nero:

1. Nero reads the original CD from the recorder and then creates and saves an image file, with the 
contents of your CD, to e.g. your hard disk. In a third step, Nero writes the image file onto a blank CD.

This gives you a very high reliability for copies, because you will be able to select options such as 
jitter correction (if a read error has been detected, Nero will automatically slow down the read 
process, and read again the audio track). These options could not be used, if you copy a CD on-the-
fly from a CD-ROM drive!

2. Nero versions 3.0 is capable of burning „on the fly“ copies using a CD-ROM drive as input device. 
You don´t need several hundred megabytes of free volume space on your harddisk any longer and 
will be able to copy CDs much faster. That´s the good news.

*G67*



Select the option On-the-fly if you want to make a direct copy from CD-ROM drive to recorder. If this 
option is not selected Nero will read the original CD from the recorder, create an image file on the hard 
disk and then in a third step write the image file onto a blank CD.

Choose „image copy“ if you

1. want the best possible reproduction (especially concerning audio tracks)

2. have enough time for an image copy which takes somewhat longer than an „on the fly“ copy

3. have enough free space on a harddisk to store the CD image (you will possibly need several hundred 
megabytes!)

4. want to write multiple copies of a CD

5. expect read errors on the source CD (for example if you can see scratches or dust on the disc)

6. want to copy mixed mode (a data track and one or more audio tracks) CDs. This is because some 
CD-ROM drives have a unholy tendency to „hang up“ (that means they don´t respond any longer to 
SCSI/DIE commands most likely crashing your computer) while reading blocks between the data and 
the audio track of a mixed mode CD. If this happens while an „on the fly“ copy takes place your 
destination CD will be crushed by a buffer underrun.

Choose „on the fly“ copy if you

1. don´t have much time

2. don´t have enough free space on your harddisk (hint: 1 minute of audio takes about 10 MB and a CD 
image file may be several hundred MB long!)

3. want to copy a CD-ROM (no audio tracks) and trust the error correction capabilities of your CD-ROM 
drive

4. want to copy mixed mode (a data track and one or more audio tracks) CDs and are pretty sure (by 
experience?) that your CD-ROM drive will read audio tracks perfectly and won´t „hang up“ (see 
above) between the data and audio track of a mixed mode CD

5. don´t care if audio index positions get lost

6. have lots of empty CD recordables J    
*G68*



Select here the drive (CD-ROM drive or recorder) from which the original CD should be read.

*G69*



The read speed of your CD-ROM drive is displayed here. *G70*



The read speed of your CD-ROM drive is displayed here.*G71*



On the property sheet Boot  you can define the settings to create a bootable CD. 

*G72*



The upper part of this property sheet is used to select the kind of model you have as input for the 
bootable CD. You can choose whether you want to use a logical drive or an image file as model for your
bootable CD. If the desired input device does not appear in the list of possible model drives then the 
reason is probably the size limitation for bootable CDs. The logical drive´s size may not exceed the 
capacity of a CD; that means 640MB.

Note: Please consider that you need to have administrator rights to be able to create bootable CDs using 
Windows NT 4.0.

*G73*



Select this option if you want to use a logical drive as model for your bootable CD. If the desired input 
device does not appear in the list of possible model drives then the reason is probably the size limitation 
for bootable CDs. The logical drive´s size may not exceed the capacity of a CD; that means 640MB.

If    the option Bootable logical drive is selected,    the settings, in the lower part of the boot property 
sheet, are dimmed indicating that Nero will check and set all the expert options automatically for you. 

*G74*



If the desired input device does not appear in the list of possible model drives then the reason is probably 
the size limitation for bootable CDs. The logical drive´s size may not exceed the capacity of a CD; that 
means 640MB.

*G75*



 If you want to use an image file of a drive as model for your bootable CD, select this option. Such image 
files contain all sectors of a drive stored in a file. Such files may for example be created using „Norton 
Disk Editor“ or „WinImage“.

*G76*



Enter a name for the image file. *G77*



If you choose to use an image file as model for the creation of a bootable CD, then Nero can´t    
automatically choose those settings for you. In this case, you have to define these settings (expert 
settings!) manually. Of course you´re responsible for the resulting CD. If the settings are incorrect you 
will get an incorrect bootable CD...

 *G78*



The lower part of the boot property page contains detailled settings for bootable CDs. These settings 
normally are dimmed indicating that Nero will check and set all the expert options automatically for you. If 
you choose to use an image file as model for the creation of a bootable CD, then Nero can´t    
automatically choose those settings for you. In this case in or if you choose to define these settings 
manually you can do so. Of course you´re responsible for the resulting CD. If the settings are incorrect 
you will get an incorrect bootable CD...

*G79*



There are three kinds of bootable CDs:

1. Floppy emulation

2. Hard disk emulation

3. No emulation

*G80*



To create a bootable CD you need a bootable drive which can be used as model for the bootable CD. 
Generally there are three kinds of bootable CDs:

Floppy emulation: To create the bootable CD you need a bootable floppy disk as model. Such a CD 
„behaves“ after booting just as if a floppy disk would have been inserted into the floppy drive. This also 
true for the drive letter which is of course „A:“. The floppy disk drive (normally „A:“) may then be 
accessed through the drive letter „B:“. The amount of the boot data is of course limited by the maximum 
capacity of the floppy disk (for example 1.44 MB).

Harddisk emulation: The model for such a CD is a bootable harddisk drive. The bootable CD „behaves“ 
as if it were drive „C:“ after booting. Your „old“ drive „C:“ may be accessed through the drive letter „D:“, 
drive „E:“ becomes „F:“ and so on. Because a CD can only store up to 640MB the size of your model 
drive must not exceed 640MB. For example if you have a 2GB harddisk with a single partition, then it´s 
impossible to use this drive as model for a bootable CD. All you can do in such a case is to change the 
size of your harddisk partition. Normally all data is lost if the partition sizes is changed using „FDISK“. But
there are serveral tools available on the market which allow partitioning changes without losing data.

No emulation: This feature is designed only for professionals, who want to create their own harddisk and
CD-ROM drivers. This method for example is used for the „Windows NT 4.0 Server CD“.

*G81*



You may enter the memory segment adress here, where the first sector of the boot data should be read 
into during the system boot process. The segment adress must be entered as a 4 digit hex number. The 
default value is 07C0. Warning: Please modify this setting only if you´re an expert concerning PC-BIOS 
and "El Torito" specification. *G82*



You may enter the memory segment adress here, where the first sector of the boot data should be read 
into during the system boot process. The segment adress must be entered as a 4 digit hex number.    The 
default value is 07C0. Warning: Please modify this setting only if you´re an expert concerning PC-BIOS 
and "El Torito" specification. *G83*



You may enter the number of sectors to be loaded during the system boot process here as a decimal 
number. The default value is 1. Please modify this setting only if you´re an expert concerning PC-BIOS 
and "El Torito" specification.

 *G84*



You may enter the number of sectors to be loaded during the system boot process here as a decimal 
number. The default value is 1. Please modify this setting only if you´re an expert concerning PC-BIOS 
and "El Torito" specification.

 *G85*



Hybrid CDs contain the well known ISO 9660 and additionally the Apple Macintosh HFS file system. Such
CDs will be both readable by Macs and PCs. Nero creates so called „non shared“ Hybrid CDs. That 
means, files to be read by Macs and PCs must exist twice (one ISO and one HFS copy of the file) on the 
CD.

On this property sheet you can select the HFS partition you wish to write onto a CD. *G86*



This list box shows all detected HFS partitions. Select the HFS partition you wish to burn. 

Note: if the list box is empty then no HFS partitions could be detected.To create Hybrid-CDs using Nero 
you need to connect your PC with a SCSI harddisk containing the HFS partition to be written on the 
Hybrid CD. Such HFS partitions can only be created and edited using an Apple Macintosh computer.

*G87*



The Apple Macintosh file system is called „HFS“. CDs containing only HFS data can only be read by an 
Apple Macintosh computer.

All detected HFS partitions will be displayed in this list box.

Note: If the list is empty, then no HFS partitions could be detected.To create a HFS CD you need to 
connect a SCSI harddisk containing one ore more HFS partitions to your PC. Such HFS harddisk 
partitions can only be created and edited using an Apple Macintosh computer. You also need a Mac to 
edit file icons and window positions. All that Nero does is to write the HFS data „as is“ on a CD. Please 
remember that the SCSI harddisk must be connected with your PC before starting the PC. Otherwise 
Nero will not be able to detect any HFS partitions. Please check the SCSI IDs to be sure your SCSI HFS 
harddisk has a unique SCSI ID.

*G88*



For users of not directly supported CD-ROM drives Nero offers the "Autodetect CD ROM". Once a CD-
ROM drive has been successfully detected by Nero it may be used as input device for „on the fly“ copies 
or to save CD tracks. Nero´s autodetection should be able to detect most CD-ROM drives that are not 
directly supported.

*G89*



All unsupported CD-ROM drives will be displayed in this box. Select the drive you want Nero to detect. 
*G90*



Here you have to define the bus type (IDE/SCSI or unknown). If possible Nero presents these options 
with reasonable default values. If SCSI or IDE is preselected as bus type it´s most likely not a good idea 
to change this settings because Nero detected the bus type by checking the driver. The result therefore is 
most certainly correct. 

 

*G91*



Please define here the bus type (IDE/SCSI or unknown). If possible Nero presents these options with 
reasonable default values. If SCSI or IDE is preselected as bus type it´s most likely not a good idea to 
change this settings because Nero detected the bus type by checking the driver. The result therefore is 
most certainly correct. 

*G92*



Here you have to define the command set of your CD-ROM drive. If you have an IDE CD-ROM then the 
command list in the dialog contains only a single entry. This is because IDE CD-ROM drives have a 
standard command set and the differences between CD-ROM models are relatively small. If you´re an 
owner of a SCSI-CD-ROM you shouldn´t need to change the preselected command set because again 
Nero has probably preselected a „reasonable“ entry. *G93*



Please define here the command set of your CD-ROM drive. If you have an IDE CD-ROM then the 
command list in the dialog contains only a single entry. This is because IDE CD-ROM drives have a 
standard command set and the differences between CD-ROM models are relatively small. If you´re an 
owner of a SCSI-CD-ROM you shouldn´t need to change the preselected command set because again 
Nero has probably preselected a „reasonable“ entry.*G94*



Choose the menu command „File“ -> „Burn HFS partition“ to select the HFS partition to be burned.



For users of not directly supported CD-ROM drives, Nero offers the menu command „CD-Rekorder“ -> 
„Autodetect CD-ROM“. Once a CD-ROM drive was successfully detected by Nero it may be used as 
input device for „on the fly“ copies or to save CD tracks. Nero´s autodetection should be able to detect 
most CD-ROM drives that are not directly supported.



REGISTRATION CARD      REGISTRIERKARTE      CARTE D'ENREGISTREMENT
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Here you can switch between Mode 1 and Mode2/XA. If these settings appear dimmed/disabled, then 
these settings can´t be modified right now. This might for example be the case if you created the ISO 
compilation using the option continue multisession. If you would continue a multisession CD using a 
different ISO- or sector format, then you would be in danger of creating an unreadable CD.



Should I write ISO data using Mode 1 or Mode2/XA?

1. Modern CD-ROM drives will read Mode 1 and Mode2/XA tracks as well. But there are some older CD-
ROM drives which will only read Mode2/XA multisession CDs. If you have such a drive, then you 
should use Mode2/XA for multisession CDs. On the other hand we´ve been told that there are even 
older CD-ROM drives which can´t read Mode2/XA track at all. So if you have such a really „ancient“ 
CD-ROM drive, then you´ve got to write some test-CDs to find out what is best for your CD-ROM 
drive.

2. If you want to continue a multisession CD written in Mode2/XA format then you´ve got to write all 
following sessions using Mode2/XA format. If you would mix Mode 1 and Mode 2 tracks on the same 
CD then you would see, that such CDs are unreadable for most CD-ROM drives, because such a CD 
format isn´t specified by the „Rainbow Books“. To make sure you don´t run into this trouble Nero will 
not allow you to switch between Mode 1 and Mode2/XA if you want to continue a multisession CD.



1. Modern CD-ROM drives will read Mode 1 and Mode2/XA tracks as well. But there are some older CD-
ROM drives which will only read Mode2/XA multisession CDs. If you have such a drive, then you 
should use Mode2/XA for multisession CDs. On the other hand we´ve been told that there are even 
older CD-ROM drives which can´t read Mode2/XA track at all. So if you have such a really „ancient“ 
CD-ROM drive, then you´ve got to write some test-CDs to find out what is best for your CD-ROM 
drive.

2. If you want to continue a multisession CD written in Mode2/XA format then you´ve got to write all 
following sessions using Mode2/XA format. If you would mix Mode 1 and Mode 2 tracks on the same 
CD then you would see, that such CDs are unreadable for most CD-ROM drives, because such a CD 
format isn´t specified by the „Rainbow Books“. To make sure you don´t run into this trouble Nero will 
not allow you to switch between Mode 1 and Mode2/XA if you want to continue a multisession CD.



Here you can enter a string, which will be displayed by the bootable CD during the boot process of your 
PC. The text may contain up to 80 characters. Notes: This text will only be displayed if the bootable CD is 
created using the „harddisk emulation“ mode.    It´s also possible that some special characters will not be 
displayed correctly because Windows is using a different character set than the BIOS, which is active 
during the boot process.



Here you can enter a string, which will be displayed by the bootable CD during the boot process of your 
PC. The text may contain up to 80 characters. Notes: This text will only be displayed if the bootable CD is 
created using the „harddisk emulation“ mode.    It´s also possible that some special characters will not be 
displayed correctly because Windows is using a different character set than the BIOS, which is active 
during the boot process.



In this listbox you can select the track(s) you want to save. Mode 1 and audio tracks are currently 
supported.



Path where you want to save the selected track(s).



Enter here the filename under which the selected track(s) should be saved. Two digits and the extension 
(.wav or .nrg) will then be automatically added by Nero

For example, if you enter "Track" as filename,    "Track" will be automatically extended by Nero to 
"Track01.wav", if the first audio track is selected. 



Path where you want to save the selected track(s).



Enter here the filename under which the selected track(s) should be saved. Two digits and the extension 
(.wav or .nrg) will then be automatically added by Nero

For example, if you enter "Track" as filename,    "Track" will be automatically extended by Nero to 
"Track01.wav" if the first audio track is selected. 



Select this option if you don't want Nero to display error messages. In this case the save process will 
continue even if some tracks haven't been saved correctly. 



Click on this button if you want to select all tracks of your CD. All tracks will then be saved.



If you have changed the inserted CD, it might be necessary to do a refresh to display the actual data of 
this CD.



Press this button to eject the CD.



Here you can set options concerning the treatment of errors that might occure during the read process.



If this option is activated, Nero will then show you an alert box if you´re about to create an unspecified CD
format. You can either abort the burn process or ignore Nero´s warning. There is no guarantee, that 
unspecified CD-ROM formats can be written on any CD-ROM drive.

Defined standard CD formats: CD-ROM, Audio-CD, Mixed Mode, Multisession CDs, etc...

Unspecified CD formats:    for example it´s not a good idea to mix mode 1 and mode2/XA tracks on the 
same CD. Another illegal CD format may be created by writing some audio tracks followed by an ISO 
mode 1 track and then to write some other audio tracks behind the others. Such CDs can not or can only 
partially be read by most CD-ROM drives. Many CD recorders can´t write additional tracks on such CDs. 
Mostly likely they panic and throw lots of SCSI/IDE errors instead (especially „illegal request“ errors).




